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Instructions for Completing DLOC Topic 1
IntroductionDLOC Topic 1 consists of a series of AWIPS-

related lessons and exercises that describe basic
radar- and warning-related features of the soft-
ware and step-by-step instructions on performing
specific tasks. There are 16 lessons and 7 exer-
cises that compose Topic 1. This printed document
contains the 16 lessons while the 7 exercises are
available on a DVD sent with your student guide
and other course materials. These exercises cover
some of the topics in this document in further
detail and have been designed specifically for use
with the WES test case data found on your local
office’s WES machine. These exercises are:

• WES Exercise 1: Map Overlays

• WES Exercise 2: AWIPS Radar-Related Tools

• WES Exercise 3: The Four-Dimensional 
Stormcell Interrogator (FSI)

• WES Exercise 4: WarnGen

• WES Exercise 5: Flash Flood Monitoring and 
Prediction (FFMP)

• WES Exercise 6: System for Convection Anal-
ysis and Nowcasting (SCAN)

• WES Exercise 7: Integrated Radar Environ-
mental Sampling

In addition to viewing these exercises on your local
WES machine, you can also review the exercise
material on the DLOC main web site at: http://
www.wdtb.noaa.gov/courses/dloc/topic1/. 
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While DLOC Topic 1 covers many details of
AWIPS needed to be a proficient warning fore-
caster, it is not all-inclusive training on AWIPS. If
you need more information on specific AWIPS
functionality, consider reviewing the AWIPS D-2D
User’s Manual (available on the AWIPS one-stop
page at https://onestop.noaa3a.awips.noaa.gov/
aumob8.3/toc.htm) which contains copious infor-
mation about the application as well as examples
of tasks you can perform in D-2D.

This document is designed as a reference that can
be used while working at an operational AWIPS
workstation. The WES exercises will provide you
further expertise in using specific applications in
D-2D. After completing all the lessons in this docu-
ment and all of the WES exercises, you should be
able to complete the proficiency exam success-
fully. However, to maintain proficiency until you
complete the course, you will want to continue
using the applications and performing tasks cov-
ered in the DLOC Topic 1 training on a regular
basis until you complete the DLOC Workshop (i.e.,
Topic 8).

Unlike the other exams in DLOC, the AWIPS Profi-
ciency Exam is a timed, paper exam that must be
proctored by your local training officer. To adminis-
ter your exam, your training officer will observe
your performance of specific tasks, inform you of
your grade, and pass along your results to WDTB.
You will need to achieve a passing score of at least
70% on the proficiency exam to receive credit for
this portion of the course.

Performance
Objectives

After completing this training, you should be able
to, without references or aids, demonstrate how to:
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1. Display and manipulate base and derived
products using the various radar pull-down
menus, including loading single and four-panel
displays, utilize cursor readout, product selec-
tion, and toggling;

2. Manipulate the display of base and derived
products through the product legend menus
and Image Properties dialog box;

3. Display, toggle, edit the display characteristics
of, and unload map overlays;

4. Utilize all of the applications listed under the
Tools menu, including the Radar Display Con-
trols GUI, the Estimated Actual Velocity Tool,
VR Shear, and the Time of Arrival tool; 

5. Effectively load multiple products in a single D-
2D display panel so that the products update
correctly;

6. Create new procedures and display them;
7. Use all-tilts products to interrogate storm fea-

tures;
8. Use the Four-Dimensional Stormcell Interroga-

tor (FSI) Extension to analyze volumetric base
radar data and interrogate storm features;

9. Create warnings, advisories, etc., using Warn-
Gen;

10. Utilize the AWIPS text windows to view infor-
mation from various text products;

11. Make One-Time Requests (OTRs) for products
from dedicated and non-dedicated RPGs,
including non-routine products (i.e., cross-sec-
tions), as well as create a Radar Multiple
Requests (RMRs) and determine the
requested products’ status;

12. Display and manipulate the FFMP suite of
products;
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13. Display and manipulate the SCAN suite of
products;

14. Utilize the Volume menu to load certain radar-
based products via the Volume Browser (i.e.,
VWP Hodograph and radar cross-sections),
load the Standard Environmental Data pack-
age to overlay environmental data on radar
displays, and use the pop-up Skew-T window
to analyze environmental soundings while
analyzing radar data;

15. Utilize keyboard shortcuts to perform certain
tasks more efficiently in AWIPS; and

16. Monitor the status of radar products in the
radar database and data ingest processes in
AWIPS, and restart slow (or dead) panes in D-
2D.

General Task
Assumptions

This document is designed so that most lessons
include tasks for you to work through to gain pro-
cedural knowledge. These examples make some
general assumptions in how the tasks are
described. These assumptions are: 

1. You are working on an operational AWIPS
workstation. Many of these tasks can be per-
formed on a WES workstation in simulation or
case review mode. However, some tasks will
not work on a WES workstation. Others may
require slight modifications to the steps
included in this documentation to work. 

2. You have a D-2D window open and it is
functioning normally. These tasks are
designed for you to work through them as you
read them. However, you may wish to quickly
review how to perform certain tasks.

3. You have access to some basic radar prod-
ucts in your current archive. Some exam-
ples may require access to specific products,
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but in general your local database must con-
tain some base products for viewing.

4. You are familiar with the following mouse
buttons nomenclature:

• Left-mouse button - Button 1,
• Middle-mouse button - Button 2,

and
• Right-mouse button - Button 3.

Each of the following lessons
uses the conventional mouse
button names in contrast to
much of the AWIPS docu-
mentation. Since more peo-
ple are used to the
conventional names, we
chose to use those labels
instead. NOTE: The Left, Mid-
dle, and Right button labels refer to the standard
right-hand configuration for mouses.
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 Lesson 1: Basic Product Displays and Manipulations
This lesson provides instructions on loading and unloading basic radar products, changing the number of panels in the 
main display, swapping panels into the main display, and using the cursor readout. As an AWIPS operator, one of the fun-
damental tasks you will perform is loading various product displays. While D-2D allows loading of products from gridded 
model fields, surface observations, and other data, the tasks in this document will focus on displaying radar products.

A. General Information about D-2D

As an AWIPS operator, you should be very familiar with how the D-2D interface works. This document highlights some spe-
cific features of D-2D to help you better understand how to perform basic tasks in AWIPS. If you have used an AWIPS 
workstation for any significant amount of time, then portions of this document will be a review. If you are new to AWIPS, 
then this document will help you to become proficient at using AWIPS.

i. Main display panel

The vast majority of the D-2D window is composed of the main 
display panel. The large pane allows for the AWIPS operator to 
look at a large area of data with a modest amount of detail or to 
zoom in to a small area with a large amount of detail. Growing 
comfortable with loading products in the main display panel, as 
well as manipulating the contents of this panel to visualize the 
data for storm interrogation, is crucial for developing AWIPS profi-
ciency.

There are multiple ways to view data in the main display panel. 
The default view is one pane of data. However, you can divide the 
main display panel into four separate panels (i.e., four-panel 
view) and load products separately into each of those panels. In 
both modes, you can view details about the data loaded in the 
main display panel by using the cursor readout to sample differ-
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ent areas of an image product. You even have the ability to toggle on and off the visibility of the various products loaded 
simultaneously in the main display.

ii. Side display panels

Although products are loaded into the main display panel, D-2D has several panels to view and store products. You can 
use the side panels to free up the main display panel for loading new images. Previously loaded products can be monitored 
in the smaller side display panels and swapped back to the main display panel when needed.

Proper usage of these side panels during warning operations allows the warning forecaster to be more effective and effi-
cient. Loading the displays with products can use precious time when you are issuing short-fuse warnings. Thus, you 
should populate all of your display panels with products for storm interrogation and near-storm environmental analysis.

iii. External windows

There are numerous tools and products in D-2D that use an external window in some way. Some of these windows are sim-
ple GUIs that users will interact with to alter the appearance of data in the main D-2D window (e.g., Radar Display Controls 
GUI). Some of these windows may be interactive tables or other displays that can control the appearance of the main D-2D 
window, but also allow for more detailed data analysis (e.g., Flash Flood Monitoring and Prediction). Other external win-
dows are applications intended for performing data analysis in an environment separate from the D-2D main window (e.g., 
Four-Dimensional Stormcell Investigator).

Regardless of the purpose of a specific external window, managing these external windows can be crucial to the proficient 
use of AWIPS during warning operations. Smaller external windows can be easily misplaced on the display or get lost 
behind larger windows. Larger external windows can obscure the view of smaller windows or even the main D-2D window. 
Window behaviors may also vary, depending on the tool or product that the window supports. Over the course of this train-
ing, each lesson and/or task that deals with an external window will directly discuss those windows and any unique behav-
iors associated with them.
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Task: Transferring Screen Products Between Panels

This task describes swapping display panels between the individual side panels and the main display panel, which allows multiple dis-
plays in a D-2D session.

Additional Assumptions:
• None

1.0. Decide Which Side Panel to Swap with the Main Display Panel

2.0. Press the Right-Mouse Button in That Pane to Swap the Displays
• You should see the display from the small pane appear in the main display panel and the main display appear in the small pane. 

• When you transfer displays, the most recent/latest time for that product will appear in each of the panes (even if that frame wasn’t visible at the time of the 
swap).

3.0. Task Complete!

B. Product Menus for Radar Products

The menu bar at the top of the D-2D window contains numerous menus to load products into the main display panel and for 
tools, or GUIs, to help in the interpretation of those products. This discussion focuses on the menus for loading the main 
suite of radar products for sites within and surrounding your CWA.

i. Menus for specific dedicated radars

Each dedicated radar for you CWA appears (assuming a standard configuration) as a separate product menu. If you have 
any Terminal Doppler Weather Radar sites in your CWA, then you may menus for each of those radars as well. All base 
and most derived radar products from a given radar will be listed under a menu labeled with that site’s four-letter identifier 
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(e.g., kabr, kmlb). NOTE: Additional non-dedicated radars may appear next to your dedicated radar menus depending on 
your local office’s D-2D configuration.

ii. The “Radar” menu: Non-dedicated radars and mosaic products

Using the default settings in AWIPS, products from non-dedicated radars in the vicinity of your CWA are listed under the 
Radar menu. In addition to these non-dedicated radars, several mosaic products are also available under the Radar menu.

Task: Load the Latest Radar Product from the AWIPS Database

This task covers a fundamental task in AWIPS: loading a loop of a radar product for the latest volume scans from the AWIPS database.

Additional Assumptions:
• You have changed the main display to the appropriate scale (usually WFO or State for radar data).

1.0. Load a Product from a Dedicated RPG

1.1. Select the pull-down menu for the desired radar (i.e., kxxx) with your mouse and press the Left-Mouse Button.

1.2. In the menu that appears, select the product you want to load with the cursor and press the Left-Mouse Button.
• If you select an option with an arrow to the right, clicking on the Left-Mouse Button will result in a submenu with more products from which you can 

select.

• If a product does not have a time/date stamp to its right, then there are currently no files in the AWIPS database for that product.

2.0. Load a Product from a Dial-Up (or Non-Dedicated) RPGs

2.1. Select the Radar menu and press the Left-Mouse Button.

2.2. In the menu that appears, choose a radar from the list with your mouse and press the Left-Mouse Button.



Warning Decision Training Branch

Lesson 1: Basic Product Displays and Manipulations

Radar & Warning Applications in AWIPS

1 - 19

2.3. In the submenu(s) that appears, select a product from the pull-down list and press the Left-Mouse Button.

3.0. Task Complete!

Task: Toggling Product Displays

This task demonstrates the basic steps in toggling products on and off (i.e., making them visible or invisible) in the main display panel. 
The two methods to accomplish this task are discussed below.

Additional Assumptions:
• You have a product loaded in the main display panel (see “Load the Latest Radar Product from the AWIPS Database” Task on page 1-13.

• The product legend is visible in the main display panel.

1.0. Method 1: Select the Product You Want to Toggle from the Product Legend (i.e., the Product Name and Date/Time Stamp 
in the Lower Right-Hand Corner of the Pane) and Press the Left-Mouse Button.

2.0. Method 2: Using the Numeric Keypad

2.1. To toggle an image product loaded in the main display, press “0” in the numeric keypad on the right-hand side of the 
keyboard.

2.2. To toggle one of the first nine graphical overlay products (i.e., one of the first nine listed in the product legend) in the 
main display, press the corresponding number (i.e., for the first graphic overlay press “1”, etc.) in the numeric keypad 
on the right-hand side of the keyboard.

3.0. Task Complete!
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Task: Viewing Cursor Readout Information

This task focuses on how to view the cursor readout information available for image products in the main display panel.

Additional Assumptions:
• There is currently a radar image product loaded in the main display panel, or

• There is currently a non-radar product loaded in the main display panel that supports cursor readout.

1.0. Manually Viewing Cursor Readout Data

1.1. Position the cursor over a storm or region of interest and press & hold the Left-Mouse Button.

1.2. Move the cursor to sample data from different range gates in the main display.
• Image product value(s),

• Mean Sea Level elevation of beam center line, 

• Above Ground Level elevation of beam center line, 

• Azimuth/range from home location, and

• Other product-specific information.

1.3. Release the Left-Mouse Button to make the cursor readout disappear.

2.0. Turn on Sampling View

2.1. Position the cursor in the main display panel away from any legends and press & hold the Right-Mouse Button.

2.2. In the pop-up menu that appears, select “Sampling” and release the Right-Mouse Button.

3.0. Task Complete!
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Task: Loading Products into Four-Panel Displays

This task demonstrates how to load products (both predefined or manually created) into a four-panel layout in the main display panel.

Additional Assumptions:
• The main display panel is set to the WFO scale.

1.0. Loading a Four-Panel Product

1.1. Select the pull-down menu for the radar of your choice and press the Left-Mouse Button.

1.2. In the menu that appears, select the “kxxx four panel” option with your mouse and press the Left-Mouse Button.

1.3. In the submenu that appears, select a four-panel product with your mouse and press the Left-Mouse Button.

2.0. Loading a Product to a Single Panel in a Four-Panel Display

2.1. Position your mouse in the main display panel and press & hold the Right-Mouse Button.

2.2. In the menu that appears, select “Four Panel Layout” with the cursor and release the Right-Mouse Button.

2.3. In the main display panel, which should now have a four-panel layout, position the cursor in one of the quarter-screen 
panels and press & hold the Right-Mouse Button.

2.4. In the pop-up menu that appears, select “Load to this panel” and release the Right-Mouse Button. 
• A yellow “L” should be visible in the lower-left corner of the panel in which you clicked.

• Always be aware of which panel has this label when manually loading four-panel products!

2.5. Select the pull-down menu for the radar of your choice and press the Left-Mouse Button.
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2.6. In the menu that appears, select a product from the pull-down menu and press the Left-Mouse Button.

2.7. Repeat Step 2.3 through 2.6 for each of the other quarter-screen panels to populate the entire display.
• The product you selected should be in the panel with the yellow “L”.

• Each time you perform Step 2.3, select a different panel in which to load a product.

3.0. Task Complete!

C. Toolbar Pull-Down Menus

 If you are new to AWIPS, then you may not be aware of how all the pull-down menus and buttons in the toolbar of the D-
2D display are used. The five pull-down menus (two on the left side of the toolbar, three towards the right) are the:

• Load Mode menu,

• Scale menu,

• Frames menu,

• Magnification menu, and

• Density menu.

These pull-down menus play a significant role in the display of any radar products loaded into the main display panel. 

i. Load Mode menu

The Load Mode menu determines the time-matching procedure for products loaded from the AWIPS 
database. Generally speaking, “Valid time seq” or “Inventory” will be the options to use for viewing 
radar products.
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Task: Load a Product from the Product Inventory

This task shows how to use the Load Mode menu for loading a single older product from AWIPS database inventory in the main display 
panel. 

Additional Assumptions:
• Make sure to change the main display to the appropriate scale (usually WFO or State for radar data).

1.0. Change the Load Mode Setting to “Inventory”

1.1. Position the cursor over the Load Mode pull-down menu and press & hold the 
Left-Mouse Button.

1.2. In the menu that appears, select “Inventory” and release the Left-Mouse But-
ton.

2.0. Select an Inventory Product

2.1. Choose the pull-down menu for the radar of your choice and press the Left-
Mouse Button.

2.2. In the menu that appears, select a product to load with the cursor and press the Left-Mouse Button.
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3.0. Select an Inventory Time

3.1. In the “Select Forecast and Inventory Times” GUI that appears, select a volume 
scan time from the “Inventory Times” list.

3.2. Select the “OK” button and press the Left-Mouse Button.

4.0. Reset the Load Mode When Finished

4.1. Select the Load Mode pull-down menu and press & hold the Left-Mouse Button.

4.2. In the menu that appears, select “Valid time seq” and release the Left-Mouse Button.

5.0. Task Complete!

ii. Scale menu

The Scale menu determines the scale of the map background on which your requested product will be 
displayed. While most radar products can be loaded on almost any scale, for storm interrogation pur-
poses you will generally want to set your scale to “WFO” for radar products.

iii. Frames menu

The Frames menu determines the number of image or graphic radar products (in AWIPS, there is a differ-
ence between the two; more on that in Lesson 5) that will be loaded into the main display panel. The maxi-
mum number of frames that can be loaded into the main display panel is 64. 

iv. Magnification menu

The Magnification menu changes the size of alphanumeric data (or labels) information, contours, and legend 
information for all products and overlays in the main display panel. The larger the Magnification menu value, 
the larger these items will appear in the main display panel.
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v. Density menu

The Density menu changes the amount of detail visible in the main display panel for all overlays (i.e., 
maps) and contoured products. Increasing the Density menu value will result in more detail being visible 
in certain background maps and contour intervals for graphic products being increased. The opposite is 

true for decreasing the Density menu value.

The impact that the Density setting has on the data in the display panel is dependent on the zoom factor. AWIPS uses a 
progressive disclosure method such that more detail becomes visible the more the user zooms in on the data display. The 
AWIPS user can override this technique by choosing the “Max” density option (i.e., forcing the display of all the data visible 
at the most detailed zoom factor).

NOTE: The frame count, Magnification, and Density can be changed after loading a product into the main display panel and 
the change will take effect immediately. For the Load Mode and Scale menus, you need to reload your products for any 
changes in those menus to take effect on the products in the main display panel.

D. Toolbar Buttons

In addition to the pull-down menus, there are also several buttons in the toolbar menu. Rather than discuss what each but-
ton does, we will just focus on some of the more important ones. These buttons are the:

• Clear button,

• Frame Navigation buttons,

• Loop button, and 

• Image Combination button.

These buttons affect how you view the image and graphic products loaded in the main display panel.

i. Clear button

Pressing the Clear button clears the main display panel so only the default background map(s) remains.
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Task: Clearing a Product from the Main Display Panel

This task will demonstrate the different ways to clear a product(s) from the main display panel of the D-2D window.

Additional Assumptions:
• None

1.0. Clear All of the Products from the Main Display Panel Using One of the Following Methods

1.1. Method 1: Select the “Clear” button and press the Left-Mouse Button.

1.2. Method 2: Use the keyboard shortcut <CTRL>-C.

2.0. Clear a Single Product

2.1. Select the product you want to unload from the product legend with the cursor and 
press & hold the Right-Mouse Button.

2.2. In the product menu that appears, select “Unload” with your mouse and release the Right-Mouse Button.

3.0. Task Complete!

ii. Frame Navigation buttons

The Frame Navigation buttons (First Frame, Step Backward, Step Forward, and Last Frame, respectively) 
allow you to toggle through the different frames loaded in the main display panel.
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iii. Loop button

Pressing the Loop button allows you to toggle on (or off) a continuous loop of the frames in the main display panel.

Task: Manually Toggling and Looping Single Elevation Angle Products in Time

This task will discuss the different ways that you can examine the different frames of an image or graphic product loop loaded in the 
main display panel by manually moving forward or backward in time from one volume scan to another.

Additional Assumptions:
• You will need to have loaded a product with a frame count of more than one.

1.0. Toggle Backward in Time Using One of the Following Methods

1.1. Method 1: Select the “<“ button in the tool bar and press the Left-Mouse But-
ton.

1.2. Method 2: Use the keyboard shortcut - “ ” (i.e., the left-arrow key).

2.0. Toggle Forward in Time Using One of the Following Methods

2.1. Method 1: Select the “>“ button in the tool bar and press the Left-Mouse But-
ton.

2.2. Method 2: Use the keyboard shortcut - “ “ (i.e., the right-arrow key).

3.0. Going to the First Frame in the Loop Using One of the Following Methods

3.1. Method 1: Select the “|<<“ button and press the Left-Mouse Button.
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3.2. Method 2: Use the keyboard shortcut - <CTRL>+” ”.

4.0. Going to the Last Frame in the Loop Using One of the Following Methods

4.1. Method 1: Select the “|>>“ button and press the Left-Mouse Button.

4.2. Method 2: Use the keyboard shortcut - <CTRL>+“ “.

5.0. Toggle Looping Using One of the Following Methods

5.1. Method 1: Select the Toggle Looping button from the toolbar and press the Left-Mouse Button.
• This method works to toggle loops on and off.

• NOTE: Method 2 does not have the same exact functionality as the Toggle Looping button.

5.2. Method 2: Use the keyboard shortcut - <Page Up> or <Page Down> (i.e., the up-arrow and down-arrow keys, respec-
tively).
• This method only works to toggle loops on.

• After initially toggling the loop on, this keyboard shortcut speeds up or slows down the speed of the loop.

6.0. Opening the Loop Properties GUI Using One of the Following Methods

6.1. Method 1:Options Menu

6.1.1. Select the Options menu and press the Left-Mouse Button.

6.1.2. In the menu that appears, select “Loop Properties...” and press the Left-
Mouse Button.

6.2. Method 2: Use the keyboard shortcut - <CTRL>+”L”.
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7.0. Adjusting Loop Properties GUI values Using One of the Following Methods

7.1. Method 1: Drag slider bars

7.1.1. Select the slider bar for the parameter you wish to change and press & hold 
the Left-Mouse Button.

7.1.2. Drag the slider to change the value to what you wish and release the Left-
Mouse Button.

7.2. Method 2: Use the arrow keys on the keyboard

7.2.1. If the Loop Properties GUI does not have the focus, position the cursor over the GUI and press the Left-Mouse 
Button.

7.2.2. Press the <Tab> key to toggle between the different slider bars.
• The property that currently has the focus will have a thin black rectangle around it (see example in Loop Properties GUI above).

• The rectangle does not appear until after you press <Tab> the first time.

7.2.3. When the property you want to change has the focus, use the arrow keys to adjust the value for that parameter.

8.0. Task Complete!

iv.Image Combination button

Pressing the Image Combination button allows you to toggle on (or off) the ability to load two separate image 
products in the main display panel. With two image products in the display, you can toggle back and forth between the two 
products. You can also fade between the two images to compare details between the images.
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Lesson 2: Editing Product Display Characteristics
This lesson provides background information and step-by-step instructions on how to modify various product display char-
acteristics in AWIPS.

A. Changing the View of a Product in the Main Display Panel

Probably the most straight forward way to change the appearance of a product loaded in the main display panel is to 
change the view of a product (i.e., to zoom in or change the center point of an product). While this task is simple, and is 
common in many visualization applications, how the task is performed can vary greatly from one application to another. 
AWIPS is no different. A proficient AWIPS operator needs to be comfortable and effective performing both of these pro-
cesses.

i. Changing the zoom factor

Changing the zoom factor in the D-2D main display panel is a critical task. Regardless of the 
product or scale used, D-2D provides several different, pre-defined zoom factors that you 
can utilize. These zoom factors are defined by the map size (in km) in the display panel. The 
smaller the range specified in the zoom menu, the greater the resolution of the data you are 
viewing, and vice versa. 

Task: Zooming In/Out of a Product View

This task will demonstrate the different ways to change the zoom factor for a product in the main display panel.



Radar & Warning Applications in AWIPSWarning Decision Training Branch

1 - 32Lesson 2: Editing Product Display Characteristics

Additional Assumptions:
• None

1.0. Change Zoom Incrementally in the Main Display Panel

1.1. To Zoom in, move the cursor to a desired center point and press the Middle-Mouse Button.
• Every button press will cause the panel to zoom in incrementally one step until you reach the maximum level of enlargement (or minimum map size) 

for that particular scale.

• Do not hold down the Middle-Mouse Button while trying to zoom in. Doing so, while moving the cursor pans (i.e., dragging the display) the main dis-
play panel.

1.2. To Zoom out, position the cursor to a point in the main display panel and press the Left-Mouse Button.
• Make sure your cursor is not on one of the products or maps listed in the legend when you zoom out. Doing so may cause that product or map to be 

toggled on/off in the display panel with no change in zoom.

• The position you place the cursor may or may not become the center point of the zoomed out image depending on the map size to which you switch.

• Every button press causes the panel to zoom out incrementally until you reach the minimum level of enlargement (or maximum map size) for that par-
ticular scale. Holding down <SHIFT> while pressing the Left-Mouse Button will cause the main display to do a full unzoom.

• Do not hold down the Left-Mouse Button while trying to zoom out. Doing so will cause the cursor readout to appear and no change in zoom will occur.

2.0. Change Zoom to a Specific Size

2.1. Position the cursor in the main display panel and press & hold the Right-Mouse Button

2.2. In the menu that appears, select “Zoom”

2.3. In the submenu that appears, select the range (in km) that corresponds to the level of zoom wanted on the display.

3.0. Task Complete!

ii. Changing the center point
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By default, zooming will automatically re-center the display each time you zoom in or out. In some instances, you may want 
to simply reposition the display to have a different center point. AWIPS supports this functionality as well.

NOTE: When viewing a product at its fullest extent, the center of the product will always be the center point of the display 
panel.

Task: Panning a Zoomed in Image in the Main Display Panel

This task will demonstrate how to pan the main display panel without zooming in or out.

Additional Assumptions:
• The main display panel has been zoomed in at least once from the maximum range of detail.

1.0. Position the Cursor in the Main Display Panel and Press & Hold the Middle-Mouse Button.

2.0. While Holding the Middle-Mouse Button, Drag the Cursor As If You Were Grabbing and Pushing the Image to Pan It in 
the Direction You Want.

3.0. When You Have Finished Repositioning the Image, Release the Middle-Mouse Button.

4.0. Task Complete!

B. Changing the Image Color Table of an Image Product

Most radar products that you view in AWIPS are image products (i.e., a product that uses color fills to indicate the data 
value for a particular range gate or location). A useful feature in AWIPS is the ability to change the legend, also known as 
the color table, for any image product. Existing color tables can be applied to an image or the color tables can be edited and 
saved as new files. Either way, knowing how to change the color table for a given product to best visualize the data for your 
needs is an important aspect of AWIPS proficiency.
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i. Switching color tables: The Image Properties GUI

Most often, when you want to use a different color table, you just swap the default 
color table to a different one. To perform this task, use the Image Properties GUI. 
This GUI lists the color table for each image product loaded in the main display 
panel. The pull-down menu for the color table (e.g., Hi-Res Ref (SGF)-ob3 in the 
example to the right) provides all the different options available.

Task: Switching the Color Table for a Radar Image Product

This task demonstrates how to change the color table to another pre-existing color table for a radar image product. 

Additional Assumptions:
• You should have an image product loaded in the main display panel to load or edit a color table.

1.0. Open the Image Properties GUI Using One of the Following Methods

1.1. Method 1: The Options menu

1.1.1. Select the Options menu and press the Left-Mouse Button.

1.1.2. In the menu that appears, select Image Properties and press the 
Left-Mouse Button.

1.2. Method 2: Use the keyboard shortcut - <CTRL>+I.

2.0. Applying a Different Color Table

2.1. With Image Properties GUI open, select the pull-down menu for the 
product you want to change and press & hold the Left-Mouse Button.
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2.2. Navigate through the menu (and submenus) that appear to select the color table you want to apply and release the Left-
Mouse Button.
• The image product refreshes with the color table that you just selected.

• You can continue changing the color table for this product from the Image Properties GUI until you find one you want.

• Close the GUI by clicking the “X” button in the upper-right-hand corner of the GUI.

3.0. Task Complete!

ii. Editing color tables: The Color Table Editor

In some instances, you may need to edit an existing color table. To per-
form this task, you will use the Color Table Editor. This GUI can be a little 
overwhelming at first because it provides the user with several options to 
change the color scale used.

In the center of the GUI, the current color scale is shown with half-arrows 
on the top and bottom of the legend. Using the arrows, the AWIPS oper-
ator specifies a range of colors based on data values to change the leg-
end. Depending on whether the image is a 4-bit or 8-bit/Super Res 
product, you can either fill that range of data values with a solid color or 
with a gradient of colors.

The colors used to fill or interpolate the range of values are determined 
from the two color panels in the GUI. These color selection panels give 
the user the option of using RGB (Red-Green-Blue) or HSB (Hue-Satura-
tion-Brightness) color models to select a color. 

When finished editing the color table, save the changes either to the old 
Color Table file or to a new file.
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Task: Editing the Current Color Table

This task demonstrates how to make changes to the current color table using the Color Table Editor.

Additional Assumptions:
• You have an image product loaded in the main display panel.

1.0. Load the Image Colors Editor Using One of the Following Methods

1.1. Method 1: Load via the product legend

1.1.1. Position the cursor over the image product name in the product legend and press & hold the 
Right-Mouse Button.

1.1.2. In the menu that appears, select “Edit colors...” and release the Right-Mouse Button.

1.2. Method 2: Load via the Image Properties GUI

1.2.1. Open the Image Properties GUI using the keyboard shortcut: <CTRL>+I.

1.2.2. In the Image Properties GUI, select the “Edit product_name” button and press the Left-Mouse Button (where 
product_name is the product to which the color table is applied).
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2.0. Pick a Range of Values to Edit by Positioning Half-Arrows Using One 
of the Following Methods
•  The arrow at the top should be at the lower end (i.e., left side) of the range, while the 

arrow at the bottom should be at the higher end (i.e., right side) of the range.

• The data values that correspond to the location of each half-arrow appear next to the 
arrow. Use this information when setting up your range of values.

2.1. Method 1: Manually dragging the half-arrows

2.1.1. Select an arrow with your cursor and press & hold the Left-
Mouse Button.

2.1.2. Drag the arrow to the desired location in the color table scale 
and release the Left-Mouse Button.

2.1.3. Repeat steps 2.1.1 and 2.1.2 for the other half-arrow.

2.2. Method 2: Utilize the directional buttons near the color table scale
• There are four buttons that control each arrow: “<“, “<<“, “>”, and “>>”.

• The “<“ and “>” buttons move the arrows on small increments in each direction.

• The “<<“and “>>” buttons move the arrows in larger data ranges.

• The top two buttons on each side control the position of the top arrow while the bottom two buttons on each side control the position of the bottom 
arrow.

2.2.1. Use the arrow buttons for one of the half-arrows to incrementally adjust its position.

2.2.2. Repeat step 2.2.1 for the other half-arrow.
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3.0. Change the Color in the Upper or Lower Color Panel Using One of the 
Following Methods

3.1. Method 1: Adjust the RGB or HSB values.

3.1.1. Choose the color model you want to use.

3.1.2. Position the slider bar for each channel to create your desired color (the new color appears in the preview window 
in the upper right-hand side of the color panel).

3.2. Method 2: Use the Hue/Saturation color wheel

3.2.1. Locate the color marker (i.e., the gray double circle, or “bulls-eye”) in the color wheel.

3.2.2. Position the cursor on the color marker and press & hold the Left-Mouse Button.

3.2.3. Drag the color marker to the desired position on the color wheel and release the Left-Mouse Button.
• Using this method, you will only be able to change the Hue or Saturation values for a given color.

• To utilize a more complete palette of colors, you will need to change to HSB color mode and adjust the Brightness value as well as reposition the color 
marker.

4.0. Fill a Range of Values

4.1. Set the range of values using one of the methods in Step 2.

4.2. Adjust the color(s) in the Upper or Lower Color panel using one of the methods in the previous step.

4.3. Select the “Fill” button in the appropriate color panel and press the Left-Mouse Button.
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5.0. Interpolating a Range of Values between Two Colors

5.1. Set the range of values using one of the methods in Step 2.

5.2. Adjust the colors in both the Upper and Lower Control panels using 
one of the methods in Step 3.

5.3. Select the “Interpolate” button in the bottom button panel with the 
cursor and press the Left-Mouse Button.

6.0. Undo, Redo, and Revert to Previously Saved Colors

6.1. Select the “Undo” button with the cursor and press the Left-Mouse 
Button to undo the last change to the color table.

6.2. Select the “Redo” button with the cursor and press the Left-Mouse Button to reapply the last change made to the color 
table.

6.3. Select the “Revert” button with the cursor and press the Left-Mouse Button to return to the last saved version of the 
color table.

7.0. Save an Edited Color Table Using One of the Following Methods
• It is a good practice to save changes to an existing color table to a file once you have made some desired changes. 

• It is often preferable to save the changes to a new file, so you can change the new file without negatively impacting 
any of the existing color tables.

7.1. Method 1: Select the “Office Save As...” button and press the Left-Mouse Button.
• Choose this method if you want the new color table to be available to all users in your office. 

• Make sure you enter a unique name for the new color table.

7.2. Method 2: Select the “Save As...” button and press the Left-Mouse Button.
• Choose this method if you want the new color table only be visible to the current user account. 
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• Make sure you enter a unique name for the new color table.

7.3. For either Method 1 or 2: Enter a name for the new color table and press “OK” button.

7.4. Method 3: Select the “Save” button and press the Left-Mouse Button.
• Choose this method if you are editing a color table that you have created and do not want to make a new version.

• Selecting the “Revert” button returns the color table to these settings unless you overwrite this color table in the future.

8.0. Task Complete!

iii. Blinking portions of a color table

Yet another option for the AWIPS operator is to not swap or edit a color 
table, but to make a portion of the legend blink. While this task in not a com-
mon one, it can be useful in certain circumstances. For instance, a warning 
forecaster who is color blind might have a difficult time distinguishing 
between two different colors used in a color table (even if the scale was 
specifically designed to mitigate this issue).

For data ambiguity issues over a small area, the cursor readout display usually is the more effective tool. However, if the 
data ambiguity issue is more widespread, or exists over several frames of a loop, blinking a color range may aid in clarity.

Task: Blinking a Range of Data Values

This task demonstrates how to select a range of values from an image product’s color table and make those colors blink.

Additional Assumptions:
• You have an image product loaded in the main display panel.
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1.0. Opening the Change Blinking GUI

1.1. Position your cursor over the name of the image product in the product legend and press & hold the Right-Mouse But-
ton.

1.2. In the menu that appears, select “Change blinking...” and release the Right-Mouse Button.

2.0. Pick a Range of Values to Edit by Positioning Half-Arrows Using One of the Following Methods
• The arrow at the top should be at the lower end (i.e., left side) of the range, while the arrow at the bottom should be at the higher end (i.e., right side) of the 

range.

• The data values that correspond to the location of each half-arrow appear next to the arrow. Use this information when setting up your range of values.

2.1. Method 1: Manually dragging the half-arrows

2.1.1. Select an arrow with your cursor and press & hold the Left-Mouse Button.

2.1.2. Drag the arrow to the desired location in the color table scale and release the Left-Mouse Button.

2.1.3. Repeat steps 2.1.1 and 2.1.2 for the other half-arrow.

2.2. Method 2: Utilize the directional buttons near the color table scale
• There are four buttons that control each arrow: “<“, “<<“, “>”, and “>>”.

• The “<“ and “>” buttons move the arrows on small increments in each direction.

• The “<<“ and “>>” buttons move the arrows in larger data ranges.

• The top two buttons on each side control the position of the top arrow while the bottom two buttons on each side control the position of the bottom 
arrow.

2.2.1. Use the arrow buttons for one of the half-arrows to incrementally adjust its position.

2.2.2. Repeat step 2.2.1 for the other half-arrow.

3.0. Blink the Range of Values by Selecting the “Enable Range” Button and Press the Left-Mouse Button.
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4.0. Stop Blinking the Range of Values by Selecting the “Disable Range” Button and Press the Left-Mouse Button.

5.0. Close the Change Blinking GUI

5.1. Select the “OK” button (to save current settings) and press the Left-Mouse Button.

5.2. Select the “Cancel” button (to cancel recent changes) and press the Left-Mouse Button.

6.0. Task Complete!

C. Printing the Contents of the Main Display Panel

There may be instances when you wish to make a hard copy of the main display panel in 
D-2D. Making hard copies is a fairly straight-forward process in AWIPS (or on a WES 
machine, if you have a printer connected to your system). The Print GUI gives you many 
of the basic options that you will see in any print dialog boxes: Color/Grayscale, Portrait/
Landscape, Scale, Copies, etc.

When you print hard copies, most often the “Invert Black/White” check box should be 
selected. This option prevents using excessive amounts of black ink. Situations where 
you will want to toggle this feature off include printing an image product that uses a pri-
marily grayscale Color Table (such as Satellite Data) or image products with Color 
Tables that use white and black as particular data values that would somehow make 
interpreting the hard copy difficult.

Task: Printing the Contents of the Main Display Panel

This task demonstrates how to make a hard copy of the main display panel contents.
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Additional Assumptions:
• None

1.0.  Open the Print GUI Using One of the Following Methods

1.1. Method 1: Use the File menu

1.1.1. Select the File menu and press the Left-Mouse Button.

1.1.2. In the menu that appears, select “Print...” and press the Left-Mouse Button.

1.2. Method 2: Use the keyboard shortcut <CTRL>+P

2.0. Using the Print GUI

2.1. Make sure the print location (Printer or File) is set correctly.

2.2. Select the document color settings (i.e., Color or Grayscale).

2.3. Select the document orientation (i.e., Portrait or Landscape).

2.4. Make sure the “Invert Black/White” check box is set correctly.

2.5. Press the “OK” button to send the job to the selected printer.

3.0. Alternate Method to Print: Press the Print Button in the D-2D Toolbar
• When pressing the print button, the contents of the main display will be sent to the printer without opening the Print GUI.

• Unless you are certain of the current printer settings, you should use one of the methods mentioned in Step 1 to print the contents of the main 
display panel.

4.0. Task Complete!
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Lesson 3: Loading and Manipulating Map Displays
This lesson presents information on map overlays that can be loaded into a D-2D display panel and how the properties of 
those maps can be adjusted. This lesson presents the basics. For more detailed practice opportunities on this topic, com-
plete DLOC Topic 1, Exercise 1 (Map Overlays) on your office’s WES machine.

A. Maps Menu

The Maps menu provides the AWIPS operator the ability to display various map overlays in the main display panel. Most 
maps display similarly to graphic products (i.e., HiRes Topo Image is the sole exception). Numerous maps can be loaded in 
a single display.

Maps are very important in visualizing and interpreting products in a display panel. Maps of County Warning Area (CWA) 
boundaries, cities, drainage basins, etc., provide the AWIPS operator with critical geographic references. Some offices may 
have similar procedure bundles where the data products displayed are the same, but the maps (and the display character-
istics of those maps) vary depending on the warning situation. Knowing how to combine maps with adequate, but unclut-
tered and distinguishable, information is an important skill that can significantly enhance the speed and effectiveness of 
your data analysis decisions during warning operations.

Task: Loading a Map Overlay

This task demonstrates how to load a map into the main display panel.

Additional Assumptions:
• None

1.0. Select the Maps Menu and Press the Left-Mouse Button.

2.0. In the Menu That Appears, Select a Map to Load and Press the Left-Mouse Button.
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3.0. Task Complete!

B. Map Legend vs. Product Legend

Whether discussing products or maps loaded in the main display panel, 
the legend (located in the lower right-hand corner of the display) provides access to important characteristics of each item 
loaded in the display. Maps, via their legend, can be toggled on and off, the color changed, the line width, and style edited. 
You also have the ability to individually set the Density and Magnification settings for a product or overlay independently 
from all of the other products in your display.

While utilizing the context-sensitive menu for each map (via the Right-Mouse Button press & hold on the map legend) can 
be powerful, the map legend must be visible to access this menu. Product legends are displayed by default whenever D-2D 
starts, a pane is cleared, or a dead pane restarted. At any given time, only the product or map legends can be displayed. 
So, to display the map legends, you will need to use one of the methods discussed in Step 1 of the task below.

Task: Unload a Map Overlay

This task will demonstrate how to unload a map that is currently loaded in the main display panel.

Additional Assumptions:
• That there is currently a map background loaded in the main display panel.

1.0. Toggle to the Map Legend View Using One of the Following Methods

1.1. Method 1: Use the main display panel background context-sensitive menu

1.1.1. Position the cursor in the background of the main display panel and press & hold the Right-Mouse Button.

1.1.2. In the menu that appears, select “Show Map Legends” and release the Right-Mouse Button.
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1.2. Method 2: Press the <Enter> key on the numeric keypad one or two times until the map legend appears.
• Each time <Enter> is pressed, the display toggles between the product legend, the map legend, and an abbreviated time stamp legend.

2.0. Unload the Map

2.1. Position the cursor over the name of the map in the map legend you wish to unload and press & hold 
the Right-Mouse Button.

2.2. In the menu that appears, select “Unload” and release the Right-Mouse Button.

3.0. Task Complete!

C. Editing Map Characteristics

Once the map legend is visible, use the context-sensitive menu (i.e., press & hold the Right-Mouse Button while the cursor 
is over the map legend) to change a map’s characteristics. All configurable map traits are listed and discussed below.

i. Set color

Since most map overlays display like a graphics product, each map is displayed as one color (gray is the 
default). The color can be changed using the “Set Color” option of the map legend menu. This option pro-
vides an interface where any RGB or HSB color can be applied to the selected map.
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ii. Line style

Most maps are composed of line segments. The line style for a specific map can be changed under the 
“Line Style” option of the map legend menu. There are three possible line styles to chose from: solid, 
dashed, or dotted (solid is the default).

iii. Line width

Similar to line style, the line width of a map can be changed using the “Line Width” option. Four different line 
widths are available with the thinnest option being the default.

iv. Magnification

Many maps also have text labels. The size of the labels can be changed for a specific map by using the 
“Magnification” option of the map legend menu. There are seven different magnification settings available 
between 0 and 2.5 with 1 being the default value.

v. Density

For some maps (e.g., cities), the level of detail visible can be adjusted. The number of markers or labels vis-
ible on a specific map is controlled under the “Density” option of the map legend menu. There are eight dif-
ferent Density settings available from 0.33 to Max (with 1 being the default value).

Just as with products, the density setting (along with Magnification to a degree) impacts the level of detail 
displayed in the main display panel. Setting the value to “Max” turns off progressive disclosure and cause 
all map information to be displayed regardless of what the current zoom factor is.
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Task: Changing a Map’s Display Characteristics

This task demonstrates how to alter the default appearance of a map overlay by changing its display characteristics.

Additional Assumptions:
• None

1.0. Load a Map into the Main Display Panel

1.1. Select the Maps menu and press the Left-Mouse Button.

1.2. In the Menu that appears, select a map to load (not Hi-Res Topo Image) with the cursor and press the Left-Mouse But-
ton.

2.0. If the Map Legend is not Currently Open, then Toggle to the Map Legend View Using One of the Following Methods

2.1. Method 1: Use the main display panel background context-sensitive menu

2.1.1. Position the cursor in the background of the main display panel and press & hold the Right-Mouse Button.

2.1.2. In the menu that appears, select “Show Map Legends” and release the Right-Mouse Button.

2.2. Method 2: Press the <Enter> key on the numeric keypad one or two times until the map legend appears.

3.0. Change the Map’s Magnification
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3.1. Position the cursor over the name of the map in the map legend you wish to modify and press & hold 
the Right-Mouse Button.

3.2. In the menu that appears, select “Magnification” and release the Right-Mouse Button.

3.3. In the submenu that appears, select the magnification value to which you want to change the map dis-
play and press the Left-Mouse Button.
• NOTE: Magnification settings only apply to maps with text labels (e.g., cities, county names).

4.0. Change the Map’s Line Width

4.1. Position the cursor over the name of the map in the map legend you wish to modify and press & hold the Right-Mouse 
Button.

4.2. In the menu that appears, select “Line Width” and release the Right-Mouse Button.

4.3. In the submenu that appears, select the line width to which you want to change the map display and press the Left-
Mouse Button.
• NOTE: Line width settings do not apply to map text labels (e.g., cities, county names).

5.0. Change the Map’s Color

5.1. Position the cursor over the name of the map in the map legend you wish to modify and press & hold the Right-Mouse 
Button.

5.2. In the menu that appears, select “Set Color” and release the Right-Mouse Button.

5.3. In the submenu that appears, select one of the pre-defined colors to change the map display to and press the Left-
Mouse Button.

6.0. Task Complete!
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Lesson 4: The Tools Menu Applications
This lesson presents information on the different tools (found under the Tools menu) in D-2D for analyzing data. These 
tools have a wide variety of uses that can be very useful to the AWIPS operator. This lesson will present the basics. For a 
more detailed set of tasks and examples, access the DLOC Topic 1 WES Exercise 2 (AWIPS Radar-Related Tools) on your 
local office’s WES machine.

A. Location Tools

i. Baselines tool

The Baselines tool, when selected, displays 10 different 
lines on the main display panel. These lines, labeled A-A’ 
to J-J’, are used to construct cross-sections from model 
and radar data from within the Volume Browser. These 
lines are “editable” by default and can be moved any-
where in the main display and adjusted to almost any 
length.
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ii. Home tool

The Home tool displays a marker (denoted with an “x” and labeled with “Home”) that is used as a 
reference point for various azimuthal and range (AZ/RAN) calculations while the marker is loaded in 
the display. One useful application is obtaining AZ/RAN information while viewing data from a non-
dedicated radar. The Home location is not editable by default, but can be made editable by selecting 
the Home product listing in the product menu while pressing the Middle-Mouse Button (or by chang-
ing the “Editable” setting in the product legend). 

iii. Choose by ID tool

The Choose by ID tool is a method of selecting feature locations as part of the Digital 
Mesocyclone Display (DMD) algorithm. This tool allows the AWIPS operator to moni-
tor the same feature over time as it moves (as long as the DMD algorithm continues 
to identify that feature).

Besides its use for the DMD algorithm, the Choose by ID tool can also be used to set 
Points, Baselines, and Home at specific locations (e.g., METARs and RAOBs).

iv. Put Home Cursor tool

The Put Home Cursor tool allows the AWIPS operator to quickly identify the location of a spe-
cific METAR station, city, or Latitude/Longitude coordinate. (NOTE: if placing Home based on 
a METAR station, the site must be a North American location) This tool uses the Put Home 
Cursor GUI when the AWIPS operator specifies the method used to put Home in the new 
location.
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Task: Defining the Location of Cursor Home

This task demonstrates two different methods to position the Home cursor location: positioning Home in the main display 
panel and by using the Put Home Cursor Tool.

Additional Assumptions:
• None

1.0. Method 1: Defining Cursor Home Location in Display

1.1. Position the cursor over the Tools pull-down menu and press the Left-Mouse Button.

1.2. In the menu that appears, select the “Home” menu option and press the Left-Mouse Button.

1.3. Position your cursor over the “Home Location” label in the product legend and press the Mid-
dle-Mouse Button to make Home editable.

1.4. Position your cursor over the location you want to be the new Home and press the Right-Mouse Button.
• You can also press and hold the Left-Mouse Button with the cursor over the old Home location and drag the Home marker to the new Home location.
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2.0. Method 2: Defining Cursor Home Location Using Station, City/State, or Lat/Lon

2.1. Select the Tools pull-down menu and press the Left-Mouse Button.

2.2. In the menu that appears, select the “Put home cursor...” option and press the Left-Mouse Button.

2.3. In the Put Home Cursor GUI that appears, choose the radio button for the proper location selec-
tion type you wish to use.

2.4. Enter the necessary information for that particular location type in the correct panel of the GUI.

2.5. Select the “Go” button with your cursor and press the Left-Mouse Button.

3.0. Task Complete!
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v. Points tool

The Points tool, when selected, displays ten points in the main display panel. These points, labeled A through J, can be 
used to generate model soundings, vertical wind profiles (using profilers and WSR-88D VAD Wind Profiles), time-height 
cross-sections, time series, and variable vs. height plots in D-2D using the Volume Browser. These points are editable 
when loaded and can be moved to any location visible in the main display panel.

B. Distance/Motion Tools

i. Distance Bearing tool

The Distance Bearing tool, when selected, displays six different lines in the main display panel. 
Each line shows the AZ/RAN information for the labeled end of the line relative to the unlabeled 
end of the line. The lines are not editable by default, but can be made editable by selecting the 
Distance Bearing tool listing in the product menu while pressing the Middle-Mouse Button or by 
changing the “Editable” setting in the product legend.

ii. Distance Speed tool

The Distance Speed tool can be used to determine the speed and direction of a 
storm or other meteorological feature. When this tool is selected, a circular marker 
will be displayed in the main display panel that the AWIPS operator can move to the 
feature they wish to track. By moving the frames forward/backward to a different 
volume scan in the loop, and moving the marker again to the feature, the forecaster 
will get a motion track with the tracks direction (in degrees) and speed (in knots). 
This tool works similarly to the WarnGen storm motion tool (see Lesson 8: Warn-
Gen Basics).
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Task: Using the Distance Speed Tool

This task demonstrates how to use the use the Distance Speed tool to determine the linear speed and direction of motion of a storm or 
other meteorological feature.

Additional Assumptions:
• You have a product with multiple frames loaded in the main display panel.

1.0. Select the Distance Speed Tool

1.1. Select the Tools menu in the D-2D toolbar and press the Left-Mouse Button.

1.2. In the menu that appears, select the “Distance Speed” tool and press the Left-Mouse Button.

2.0. Use the Tool to Determine the Features Speed and Direction of Motion.

2.1. Select the “Drag me to feature” marker and press & hold the Left-Mouse Button.

2.2. Move the marker to the feature you want to track and release the Left-Mouse Button.

2.3. Step the loop in the main display panel backwards several frames.

2.4. Again, select the feature marker and press & hold the Left-Mouse Button.

2.5. Move the marker over the same feature you originally tracked in Step 2.2 and release the Middle-Mouse Button

2.6. Toggle back in forth several frames in the main display panel to ensure that the storm motion vector is accurate for the 
storm feature you are tracking.
• If the track is a little off, keep repeating steps 2.1 through 2.5 to fine tune the storm motion vector.
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• Depending on the feature you are tracking, this process can sometimes take several iterations before you have a storm motion vector you are confident 
is accurate.

3.0. Task Complete!

iii. Time of Arrival / Lead Time tool

The Time of Arrival / Lead Time tool displays a tracking line 
from a feature’s initial starting point in a previous frame to its 
final position in the current frame. Once the AWIPS operator 
sets both of these points, an Arrival Point is displayed. The 
Arrival Point can be dragged anywhere along the line to get the 
arrival and time and distance of the feature to that point. In 
addition to calculating these variables for a point feature, this 
tool can also be used to determine arrival time and distance for 
a Circular Front or Polyline for situations where these options 
are more representative.

C. Radar-Related Tools

i. VR-Shear tool

The VR-Shear tool is used in conjunction with a Radial Velocity (or Storm 
Relative Mean Radial Velocity Map) product to calculate the velocity differ-
ence (or shear) between two points. The AWIPS operator positions the two 
endpoints of the VR-Shear tool over the desired range gates. When posi-
tioned, the VR-Shear tool determines the speed difference (in kts), the dis-
tance between end points (in nautical miles), the shear (in s-1) and the 
distance from the radar (in nautical miles).
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Positive shear values measured by the tool indicate cyclonic shear, while negative shear values indicate anticyclonic shear. 
If either end point is not directly over a range gate with valid velocity data, the phrase “no data” will appear in place of the 
shear value.

NOTE: If you pan the main display panel while using the VR-Shear tool to the point where you no longer see the tool end-
points, pressing the Right-Mouse Button in the main display panel will cause the tool to snap to the point where you clicked 
the button. Also, when using the VR-Shear tool in four-panel mode, the tool will appear in different colors in each separate 
panel of the main display window.

ii. Radar Display Controls tool

The Radar Display Controls tool is a GUI that gives the AWIPS operator control over the 
appearance of several different radar products, including Storm Track (STI), Tornado Vor-
tex Signature (TVS), Digital Mesocyclone Display, and Storm Relative Mean Radial Velocity 
Map (SRM). Of all of these options, the most likely use is to alter the appearance of SRM 
products. The controls for the appearance of SRM products appears in the bottom panel of 
the GUI.

Using the Radar Display Controls tool, the AWIPS operator can select from one of three dif-
ferent storm motion vectors to generate a SRM product: storm motion from the last use of 
WarnGen or Distance/Speed Tool (velocity is the zero vector if older than 24 hours), the 
average storm motion from the STI algorithm, or an operator-specified custom storm 
motion. The storm motion vector used for the SRM data values is displayed below the color 
scale (in the upper-left-hand corner of the panel). The settings chosen by the AWIPS oper-
ator are workstation specific. So, these settings will affect all displays on that same work-
station, but not displays on any other workstations in the WFO.

When viewing SRM products in D-2D, always check the storm motion values for the prod-
uct being displayed. The last value used may no longer be representative, or desired, for 
the current situation.
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Task: Change the SRM Product Storm Motion in the Radar Display Controls GUI

This task will demonstrate how forecasters can update the storm motion estimate used by the Storm-Relative Velocity Map 
(SRM) product. There are three different ways to change the velocity estimate for SRM in the Radar Display Controls GUI. 
This task will show how to set a custom storm motion. The other two methods (use the storm track from WarnGen and use 
the STI average motion) are implemented in a similar manner.

Additional Assumptions:
• None

1.0. Load a SRM Product from Your Dedicated RPG

1.1. Select the pull-down menu for the desired radar (i.e., kxxx) with your mouse and press the Left-Mouse Button.

1.2. In the menu that appears, select the “kxxx Best Res 8-bit SRM” submenu and press the Left-Mouse Button.

1.3. In the submenu that appears, select the “0.5 SRM” product.

2.0. Open the Radar Display Controls GUI

2.1. Select the “Tools” menu and press the Left-Mouse Button.

2.2. In the menu that appears, select the “Radar Display Controls...” option and press the Left-Mouse Button.

3.0. Change the SRM Storm Motion to a Custom Value

3.1. In the SRM section of the Radar Display Controls GUI, select the “Custom Storm Motion” radio button (if not already 
selected).

3.2. Change one of the custom storm motion parameters
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3.2.1Position the cursor over either the “Dir” or “Spd” slider bar.

3.2.2Press and hold the Left-Mouse Button over the slider bar.

3.2.3Drag the slider bar to the left or the right to change the value for that parameter.
• Changing either value should result in an immediate change in the SRM product shown in the D-2D main display panel.

• If the product does not immediately update, try zooming in or out in the main display panel.

• If the SRM product still doesn’t respond, try clearing the main display panel and restarting this task.

3.3. Set the custom storm motion more precisely using one of the following two methods.

3.3.1Method 1: Select the numeric value text box to the right of one of the slider bars and type in the exact value you 
want.

3.3.2Method 2: Position your cursor over the up and down arrows to the right of the Custom Storm Motion text boxes 
and press the Left-Mouse Button over an arrow to increment the values up or down by one.

4.0. Task Complete!

iii. Estimated Actual Velocity (EAV) tool

The Estimated Actual Velocity (EAV) tool is a radar analysis tool that 
allows forecasters to estimate the actual wind speed based on a 
user defined wind direction, the measured radial velocity, and the 
intersection angle between the radar beam and wind direction. This 
tool may be useful to some forecasters during situations where a 
more exact wind speed is desired to include in a warning, follow-up 
statement, or other text product. When the angle between these two 
vectors is relatively small (i.e., less than 45 degrees) and the fore-
caster has a good estimate of the actual wind direction at that height 
and location, than this tool’s wind speed values are representative of 
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what is actually occurring. When this angle is less than 20 degrees, the wind speeds returned by the tool will be similar to 
the radial velocity values and provide little additional benefit. When this angle is greater than 45 degrees, the equation used 
by the EAV tool becomes too sensitive to incremental changes in the angle to reliably determine the actual velocity.

The tool allows users to obtain the actual wind speeds in two different manners. First, the wind speed and direction are 
listed at either end of the line tool that forecasters use to indicate the wind direction. Second, users can access the EAV 
estimated velocity at any given point by using sampling. 

When using the EAV tool, there are some guidelines you should follow:

• You should only use the EAV tool on super-resolution or 8-bit base velocity (V) data

• DO NOT use the EAV tool on Storm-Relative Velocity Map (SRM) product displays

• Only use the EAV tool in well-sampled radial velocity areas where the wind direction is likely to be unambiguous.

More information on the EAV Tool can be found in WES Exercise 2 and in DLOC Topic 5, Lesson 3.
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Lesson 5: Overlaying Multiple Products on a Single Display
This lesson provides instructions on loading multiple products into a single display. It references tasks from previous les-
sons (i.e., loading and editing product displays) and introduces new tasks designed to help forecasters maximize workflow 
for increased efficiency.

A. Graphic Products vs. Image Products

When working with D-2D, it is important to know and 
understand the difference between image products 
and graphic products. While, in many circum-
stances, these differences may seem insignificant, 
they are important. 

i. Graphic products

In D-2D, graphic products are maps containing plot-
ted or contoured data, soundings, or other plotted 
data. Graphic products can be either observational 
data or model output products. 

Graphic products are beneficial for data analysis 
because multiple graphic products can be loaded 
into a single display panel and viewed concurrently. 
These products can also be overlaid on other image 
products, making them a useful analysis tool.

Graphic products contain less visual information 
than image products. Cursor sampling only works for 
certain point measurements, soundings, etc., in 
graphics. A single graphic product is displayed 
entirely in one color, which can sometimes cause legibility issues. For instance, fields in a METAR station model plot are all 
a single color, sometimes impeding interpretation. Further legibility issues can result from small font sizes or contour 



Radar & Warning Applications in AWIPSWarning Decision Training Branch

1 - 64Lesson 5: Overlaying Multiple Products on a Single Display

widths. Changing the panel Magnification and Density settings, or changing the product specific parameters, can help miti-
gate some legibility issues with graphic product displays.

ii. Image products

Simply stated, image products in D-2D are continuous 
fields of data that are represented by color fills. Due to 
how data are visualized in AWIPS, this characteriza-
tion means much more. 

D-2D provides more control over the display of image 
products. For instance, users can change the Color 
Table of an image product to aid in visualization. The 
user can also blink a range of values in that color 
table to help differentiate certain values in the prod-
uct. Image products even allow the AWIPS operator 
to determine the specific data value at any point in an 
image through the cursor sampling function.

Due to the continuous nature of the data in an image 
product, it is possible to only display one (or two in 
image combination mode) image product in a display 
panel at one time. However, four-panel layouts permit 
viewing multiple image products simultaneously; 
Graphic products are easily overlaid on top of an 
image product.

B. Importance of Loading Order

AWIPS operators commonly overlay graphics and image products on a single display panel. The sequential order of how 
products are loaded into the display panel is crucial to how those products update. The first product loaded into a display 
determines the frequency at which the frames in that display panel will update. 
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For instance, if a 0.5o Reflectivity product is loaded first, then a new frame is added to the loop when the next new 0.5o 
Reflectivity product is received in the AWIPS database (i.e., about every 5-10 minutes). However, if METAR surface obser-
vations are the first product loaded in the display panel, then the next frame in that display panel may not update for 
another hour.

When setting up a display panel for storm interrogation, radar image products should be the first product loaded in the dis-
play panel. If the panel does not have a radar image product, a radar graphic product (or another rapidly updating product) 
should be loaded first in that display. While some exceptions to this rule exist, particularly when comparing model and 
observational data, this guideline works well in most situations.

C. Different Types of Graphic Product Overlays

Graphic products can vary significantly in their functionality and in their look and feel. This variation depends on the type of 
graphic product, how products are loaded, etc. While much diversity exists among the types of graphic products, for the 
purposes of warning operations they generally fall into three categories: radar product overlays, Volume Browser product 
overlays, and other product overlays.

i. Radar product overlays

Numerous radar graphic products can be overlaid on radar 
image products. These products include Storm Track (STI), 
Tornado Vortex Signature (TVS), and Meso Rapid Update 
(MRU), along with output from other algorithms. Most of 
these products have multiple pages of overlays (up to 6 
pages per product).
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Task: Loading and Toggling Radar Graphic Overlay Products

This task demonstrates how to load and toggle a graphic product overlay into a frame after first loading an image product.

Additional Assumptions:
• None

1.0. Load an Image Product

1.1. Select the pull-down menu for one of your local radars and press the Left-Mouse Button.

1.2. In the menu that appears, select “0.5 Z/SRM8” (or similar image product) and press the Left-
Mouse Button.

1.3. If necessary, press the “.” key on the numeric keypad to toggle between the images (i.e., if you 
selected an image combination product).

2.0. Load Graphic Product Overlays

2.1. Select the same pull-down menu from Step 1.1 and press the Left-Mouse Button.

2.2. In the menu that appears, select the “kxxx Graphic” menu (where 
kxxx is your chosen radar) and press the Left-Mouse Button.

2.3. In the subsequent submenu, select the graphic product you want to 
load and press the Left-Mouse Button.
• Remember to look at the date/time information in the menu to ensure the product you 

select currently has data in the AWIPS database.

• If the product you load has multiple pages, each page of information will display in the same color. However, only one page is typically visible with 
the other pages available to be toggled.
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3.0. Toggle between Pages of Graphic Product Overlays Using One of the 
Following Methods
• As long as one page of the table is toggled on, all of the icons in the main display 

remain visible. 

• By default, each page for a single graphic overlay product loads using the same color, 
which helps the user distinguish between multiple overlay products loaded on the same panel.

3.1. Method 1: Select the product page you wish to toggle from the product legend in the main display panel and press the 
Left-Mouse Button.

3.2. Method 2: Using the keyboard shortcuts

3.2.1. Starting at the bottom of the product legend, count up to the graphic product you wish to toggle.

3.2.2. As long as the number is nine or less, use that number in the numeric keypad on the keyboard to toggle that page 
of the graphic product.

4.0. Task Complete!

ii. Volume Browser product overlays

In many situations it is useful to display near-storm environment model data as product overlays on radar imagery. In addi-
tion, many products loaded from the Volume Browser can also be displayed as an image product (if the panel has the room 
for an image product). This feature can come in handy when visualizing environmental parameters that can be large in 
magnitude and have large gradients over small areas (i.e., CAPE).

NOTE: A detailed description of the Volume Browser and its usage falls outside the scope of DLOC Topic 1. However, on 
occasion the Volume Browser is necessary for warning operations. This document assumes you have a basic understand-
ing of the Volume Browser, but also provides detailed instructions so you can complete the necessary tasks.



Radar & Warning Applications in AWIPSWarning Decision Training Branch

1 - 68Lesson 5: Overlaying Multiple Products on a Single Display

Task: Overlaying CAPE on a Base Reflectivity Product

This task will demonstrate how to use the Volume Browser to load a graphic overlay product (CAPE in this example) in the same dis-
play panel as an image product (Base Reflectivity).

Additional Assumptions:
•  If you do not have any active weather in your area, try this example on your office WES machine using the WES test case (i.e., 2006Aug24).

1.0. Load a Base Reflectivity Product in the Main Display
• Make sure that the main display is clear of all products (image or graphic).

• Make sure that the main display panel is set to WFO Scale.

1.1. Choose a local radar to use, select its pull-down menu from the D-2D toolbar, and press the Left-
Mouse Button.

1.2. In the menu that appears, select the “kxxx Best Res Refl” menu and press the Left-Mouse But-
ton.

1.3. In the submenu that appears, select “0.5 Refl” and press the Left-Mouse Button.

2.0. Open the Volume Browser GUI

2.1. Select the Volume menu and press the Left-Mouse Button.

2.2. In the menu that appears, select “Browser...” and press the Left-
Mouse Button.
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3.0. Load LAPS CAPE on the Base Reflectivity Product
• NOTE: Menu and submenu options that appear in light green in the panel 

menus are available in the database while parameters that appear in black are 
not.

• If for some reason LAPS CAPE is not available at the time you try this task, try 
to use CAPE from a different source (or even a different Field from the LAPS 
output).

3.1. Select LAPS as the Source type

3.1.1. In the Source panel, select the Grid menu and press 
the Left-Mouse Button.

3.1.2. In the menu that appears, select LAPS and press the 
Left-Mouse Button.

3.2. Select CAPE as the Field type
• NOTE: The following steps are for a common Volume Browser configuration. Your local office configuration may be different.

• If your office configuration differs from what is discussed in these directions, and you are unfamiliar with where “Pos Buoy En” is located in your 
office set up, talk to your SOO or another forecaster at your office for assistance.

3.2.1. In the Field panel, select the Sfc/2D menu and press the Left-Mouse Button.

3.2.2. In the menu that appears select Convective and press the Left-Mouse Button.

3.2.3. In the submenu that appears select “Pos Buoy En” and press the Left-Mouse Button.
• Once you have selected this field, “Surface” should automatically be selected in the Planes panel with “LAPS Surface Pos Buoy Energy (J/Kg)” high-

lighted in the Product Selection List panel.

• If “Surface” does not automatically appear, select Surface from the Misc menu in the Planes panel and press the Left-Mouse Button.

3.3. Select the Load button at the bottom of the Volume Browser and press the Left-Mouse Button.

4.0. Edit the Contour Interval for CAPE
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4.1. Position the cursor over the listing for CAPE (i.e., Pos Buoy Energy) in the product legend and press & hold the Right-
Mouse Button.

4.2. In the menu that appears, select Density while still holding the Right-Mouse Button.

4.3. In the submenu that appears, select “2” and release the Right-Mouse Button.
• The number of CAPE contours should approximately double.

• Repeat Step 4.1 and try other menu (and submenu) options to further customize the appearance of the CAPE contours. This method of trying different 
options is the best way to learn the various graphic product display options that are available.

5.0. Task Complete!

iii. Other product overlays

Besides radar products and products loaded using the Volume Browser, there are many other graphic overlay products 
available in AWIPS. These products (such as METAR surface observations, warning polygon graphics, and lightning data) 
are mostly located under the Obs or NCEP/Hydro menus in D-2D.

Task: Overlaying a Surface Plot on a Base Reflectivity Product

This task demonstrates how to load a graphic overlay (METAR surface observations) in a display panel with an image product (Base 
Reflectivity).

Additional Assumptions:
•  If you do not have any active weather in your area, try this example on your office WES machine using the WES test case (i.e., 2006Aug24).

1.0. Load a Base Reflectivity Product in the Main Display
• Make sure that the main display is clear of all products (image or graphic).

• Make sure that the main display panel is set to WFO Scale.
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1.1. Choose a local radar to use, select its pull-down menu from the D-2D toolbar, and press the Left-
Mouse Button.

1.2. In the menu that appears, select the “kxxx Best Res Refl” menu and press the Left-Mouse But-
ton.

1.3. In the submenu that appears, select “0.5 Refl” and press the Left-Mouse Button.

2.0. Load METAR Station Plots on Base Reflectivity

2.1. Select the Obs pull-down menu and press the Left-Mouse Button.

2.2. In the menu that appears, select “Station Plot” and press the Left-Mouse Button.

3.0. Edit the Size of the Station Plot Display

3.1. Position the cursor over the listing for METAR in the product legend and press & hold 
the Right-Mouse Button.

3.2. In the menu that appears, select “Magnification” while still holding the Right-Mouse 
Button.

3.3. In the submenu that appears, select “2” and release the Right-Mouse Button.
• The size of the station plot should be about twice as big and much more legible.

• Repeat Step 3.1 and try other menu (and submenu) options to further customize the appearance of the METAR station plot. This method of trying dif-
ferent options is the best way to learn the various graphic product display options that are available.

4.0. Task Complete!
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Lesson 6: Creating and Editing Procedures
This lesson provides instructions on creating and editing procedures in AWIPS. It discusses both procedures and bundles, 
as well as the various Procedure GUIs that open, create, and edit procedures and bundles. Lastly, it touches on the History 
List and how it can be used to create procedure bundles, also.

A. Procedures

Procedures are user-generated tasks that automatically display graphics and/or image products and maps in the main dis-
play panel. Procedures provide a convenient way to display commonly used products (or products that are useful for a par-
ticular weather situation). All procedures have user-defined names to identify the types of product/map combinations 
included in the procedure.

B. Bundles

Bundles are the individual groupings of products that are contained within a procedure. Each procedure is composed of 
one or more bundles. Bundles contain not only all of the products loaded in the main display panel, but also any applicable 
display parameters (i.e, frame count, looping speed, color tables, etc.). When bundles are created, D-2D provides default 
names based on the products and maps that the display contains. The AWIPS operator can rename any bundle.

C. Using the Procedure GUIs

When creating, editing, or loading procedures, use Procedure GUIs - the various windows that open an existing procedure, 
create a new procedure, or add new bundles to an existing procedure.

Task: Opening an Existing Procedure

This task demonstrates how to open an existing procedure in AWIPS.
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Additional Assumptions:
• None

1.0. Open the Procedures GUI Using One of the Following Methods

1.1. Method 1: Using the File menu

1.1.1. Select the File menu and press the Left-Mouse Button.

1.1.2. In the menu that appears, select “Procedures” and press the Left-Mouse Button.

1.1.3. In the submenu that appears, select “Open” and press the Left-Mouse Button.

1.2. Method 2: Using the keyboard shortcut - <CTRL>+O.

2.0. Choose a Procedure to Open

2.1. From the Open Procedure GUI, select a procedure from the list and press the Left-Mouse 
Button.

2.2. Select the “OK” button and press the Left-Mouse Button.

3.0. Select a Bundle to Open

3.1. In the Procedure GUI, select a bundle from the list and press the Left-Mouse Button.

3.2. Select the “Load” button and press the Left-Mouse Button.

4.0. Task Complete!
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Task: Create a New Procedure

This task demonstrates how to create a new procedure and add a new bundle to that procedure.

Additional Assumptions:
• None

1.0. Set Up the Main Display
• Load all the products (image and graphics) and maps in the main display panel exactly as you want them to appear in the bundle. 

• Remember to keep the load order in mind. The first product determines the refresh frequency.

• For instructions on loading products and maps into the main display, review the previous sections of this document on Basic Product Displays and Manip-
ulations, Editing Product Display Characteristics, Loading and Manipulating Map Displays, and Overlaying Multiple Products on a Single Display.

1.1. Load a product(s) into the main display panel (see Lesson 1).

1.2. Load any additional maps into the main display panel (see Lesson 3).

1.3. Edit the display characteristics (i.e., color table, graphic colors, Magnification, etc.) for the products and maps in the 
main display panel (see Lessons 2 & 3).
• Take time to change the display traits of graphic overlay products and maps prior to saving the procedure. Make use of the different colors and line 

styles available, using brighter colors and thicker (or solid) lines for items you want to stand out more. Use thin lines for reference information and to 
reduce clutter.

• If you have several graphic or map overlays loaded in the main display, consider toggling some of them off prior to creating the procedure. This way, 
the overlays are available in the procedure, but initial clutter in the display is reduced.

2.0. Open the New Procedures GUI Using One of the Following Methods

2.1. Method 1: Using the File menu

2.1.1. Select the File menu and press the Left-Mouse Button.
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2.1.2. In the menu that appears, select “Procedures” and press the Left-Mouse Button.

2.1.3. In the submenu that appears, select “New” and press the Left-Mouse Button.

2.2. Method 2: Using the keyboard shortcut - <CTRL>+N.

3.0. Add a Bundle to the New Procedure GUI

3.1. In the Procedure GUI that appears, select the “Copy In” button and press the Left-
Mouse Button.

3.2. Select the “Save” or “Save As...” button and press the Left-Mouse Button.

3.3. In the “Save Procedure As” window that appears, enter the name you want to assign to 
the new procedure, select the “OK” button, and press the Left-Mouse Button.
• The procedure window, originally titled “Procedure (untitled)”, should now be titled “Procedure 

(procedure_name)”, where procedure_name is the name you just gave the new procedure.

• You can continue creating new bundles in the new procedure or you can select the “Close” button and press the Left-Mouse Button to close the win-
dow.

4.0. Task Complete!

Task: Changing Existing Bundles in a Procedure

This task demonstrates some of the ways to modify existing bundles and procedures.

Additional Assumptions:
• None
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1.0. Open the Procedures GUI Using One of the Following Methods

1.1. Method 1: Using the File menu

1.1.1. Select the File menu and press the Left-Mouse Button.

1.1.2. In the menu that appears, select “Procedures” and press the Left-Mouse Button.

1.1.3. In the submenu that appears, select “New” and press the Left-Mouse Button.

1.2. Method 2: Using the keyboard shortcut - <CTRL>+O.

2.0. Choose a Procedure to Open

2.1. From the Open Procedure GUI, select a procedure from the list and press the Left-Mouse Button.

2.2. Select the “OK” button and press the Left-Mouse Button.

3.0. Add a Bundle to a Procedure

3.1. Set up the main display panel with maps and products desired for a new bundle in an existing procedure (see Lessons 1-
3).

3.2. In the Procedure GUI, select the “Copy In” button and press the Left-Mouse Button.

4.0. Change the Name of a Bundle

4.1. In the Procedure GUI, select a bundle whose name you want to change and press the 
Left-Mouse Button.

4.2. Select the “Rename...” button and press the Left-Mouse Button.

4.3. In the window that appears, change the name for the bundle in the text window.
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4.4. Select the “OK” button and press the Left-Mouse Button.

5.0. Change the Order Bundles Are Listed in a Procedure

5.1. Select a bundle from the list in the Procedure GUI and press the Left-Mouse Button.

5.2. Select the “Up” or “Down” button and press the Left-Mouse Button.
• Each time you press one of these buttons, the highlighted bundle will be moved up or down in the stack.

6.0. Delete Bundles from a Procedures

6.1. Select the bundle you want to delete from the Procedure GUI display panel and press the 
Left-Mouse Button.

6.2. Select the “Delete” button and press the Left-Mouse Button.
• That bundle should no longer be listed in the Procedure GUI display panel.

• NOTE: Be careful when deleting bundles. There is no undo option in the GUI. If you accidently delete a bundle, close the Procedure GUI without sav-
ing and then reopen the procedure to revert back to the last saved copy of the procedure.

7.0. Save Changes to a Procedure

7.1. To overwrite the old version of the procedure, select the “Save” button and press the Left-Mouse Button.

7.2. To save the procedure as a new file, select the “Save As...” button and press the Left-Mouse Button.

8.0. Task Complete!
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D. History List

The History List is a GUI that contains the most recent bundles that were displayed in the main display 
panel (the most recent bundle appears at the top of the list). Procedures (or procedure bundles) may be 
built from bundles contained in the History List.

The History List can be accessed in two ways:

1. Under the File menu, select “History List...” and press the Left-Mouse Button.

2. Use the keyboard shortcut: <CTRL>+H.
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Lesson 7: Using All Tilts Products to Interrogate Storms
This lesson provides information on, and instructions for, using all tilts radar products. Besides explaining the steps for 
loading this product and interrogating storms, this lesson also incorporates some best practices for using all tilts products 
during warning operations.

A. What Are All Tilts Products?

All Tilts products are loops of radar base data in AWIPS where every available elevation angle for each volume scan is 
loaded in a loop. The AWIPS operator uses the arrow keys on the keyboard to step through the products for either a con-
stant elevation angle or volume scan. NOTE: The effectiveness of this product depends on the number of frames in the 
loop for the main display panel and the products available in the AWIPS database for a given radar.

B. Important Points to Remember When Using All Tilts Products

i. Avoid using WarnGen with all tilts products

In general, WarnGen should be loaded on a display panel with single elevation angle product, not an all-tilts product. All tilts 
products offer a limited number of volume scans in the frame loop to determine storm motion. Loops of single elevation 
angle products are better suited for that purpose. Use All Tilts products to interrogate storm structure instead.

ii. For non-dedicated radars, use Radar Multiple Requests to have access to all 8-bit base data

When interrogating storms that are best covered by a non-dedicated radar, remember to use Radar Multiple Requests 
(RMRs) to download the 8-bit base data from those radars. This process ensures having the best quality data from those 
radars for storm interrogation.

iii. Set the frame count to 64

To maximize the effectiveness of All Tilts products, set the frame count to the maximum (i.e., 64 frames in AWIPS OB 8.3) 
amount possible. This change provides 3-4 full volume scans of base data available for storm interrogation.
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iv. If lost, go to the last frame

Because of the nature of the product, users can get confused to which volume scan is the latest, etc. If you find yourself in 
this situation, click on the last frame button in the D-2D toolbar to move to the last frame in the loop. This process ensures 
you’re viewing data from the latest volume scan.

Task:  Loading an All Tilt Products into the Main Display Panel

This task covers loading an All Tilts product in the main display panel and the two methods for navigating through those products.

Additional Assumptions:
• None

1.0. Load an All Tilts Radar Product into the Main Display Panel

1.1. Set Frame Count to 64

1.1.1. Select the Frames pull-down menu and press the Left-Mouse Button.

1.1.2. Position the cursor over “60 ~ 64” and press the Left-Mouse Button.

1.1.3. Position the cursor over “64” and press the Left-Mouse Button.

1.2. Load an All Tilts Product from the Menu

1.2.1. Select the menu for the desired radar (i.e., kxxx) with your cursor and press the 
Left-Mouse Button.

1.2.2. In the menu (and submenu) that appears, select an “all tilts” product you want to 
view (i.e., base data, base data combination, or rapid update algorithm products) 
and press the Left-Mouse Button.
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1.3. If loading an all tilts combination product (e.g., All Tilts Z/SRM8), use the “.” on the keypad to toggle between the 
image products

2.0. Step Forward and Backward in Time Using One of the Following Methods

2.1. Method 1: Using the keyboard directional arrows to step through frames (preferred method)
• After loading an all tilts product, use the four directional arrows on the keyboard to navigate through product loop.

• Constant Volume Scan Viewing: The “ “ and “ “keys advance to the next highest or lowest elevation angle avail-
able in the current volume scan, respectively.

• Constant Elevation Angle Viewing: The “ “ and “ “ keys will advance to the next or previous image available for the current elevation angle, 
respectively. 

2.2. Method 2: Using the Toolbar buttons to step through frames
• After loading an all tilts product, the “<“ and ”>” buttons in the toolbar moves the frame forward and backward. 

• To determine frame order, the highest elevation angle in the latest volume scan is the most recent product while the lowest elevation angle in the oldest 
volume scan is the oldest product. While viewing the lowest elevation angle of a given volume scan, the next oldest product is the highest elevation 
angle of the previous volume scan.

• Pressing the “|<<“ or “>>|” buttons in the toolbar will take you the oldest and most recent product in the all tilts display, respectively.

3.0. Task Complete!
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C. Four-Panel All Tilts Displays

In addition to standard all tilts displays, AWIPS also supports 
the use of all tilts products being displayed in a four-panel lay-
out. Four-panel all tilts displays can be loaded manually (i.e., 
load all-tilts products into each quadrant of a four-panel prod-
uct manually) or using a four-panel all tilts menu option in the 
“kxxx Dual-Pol Prods” submenu. As you can tell from the 
name, this functionality was added to AWIPS to help support 
the future release of WSR-88D dual-polarimetric radar prod-
ucts. 

All of the items mentioned in Section B of this lesson apply for 
the four-panel all tilts products as well as the single panel all 
tilts products. In addition to the previously mentioned important 
points, there is one other issue to remember with the four-
panel all tilts displays. If you manually load radar products into 
the four-panel, you have the ability to combine all-tilts products 
with other products that are generated only once per volume 
scan. If you do combine products in this manner, you may end 
up with a display you did not expect. 

If you first load an all tilts product and then load a single tilt product, the single tilt product will time match to the all tilts prod-
uct. In other words, your display panel navigation will function just like any other all tilts product. As you move up and down 
in elevation, the single tilt product will not change.

If you load the single tilt product first and then load the all tilts product, the all tilts product will time match the single tilt prod-
uct. In other words, the all tilts product will not behave like an all tilts product at all. It doesn’t matter which quadrant of the 
four-panel you load the single tilt product into, either. Just like when you load multiple overlays into a single display, all of 
the products will match the first product loaded into the display. So, keep this fact in mind if you decided to create any non-
standard four-panel displays!
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Lesson 8: The Four-Dimensional Stormcell Interrogator (FSI)
This lesson presents information on the Four-Dimensional stormcell Interrogator (FSI) Extension for analyzing base radar 
data. The FSI Extension is based on the National Severe Storm Laboratory (NSSL) Warning Decision Support System - 
Integrated Information (WDSSII) and is accessed from within D-2D. This lesson will present the basics on this application. 
For a more detailed set of examples of how to perform certain tasks in FSI, access the DLOC Topic 1 WES Exercise 3 (The 
Four-Dimensional Stormcell Interrogator) on your local office’s WES machine.

A. FSI Basics

The FSI Extension to D-2D allows forecasters to view base radar data 
for a storm, or an area of storms, in a four-panel layout. Forecasters 
can view any of the four standard base data products (i.e., Reflectivity, 
Velocity, Storm-Relative Mean Velocity Map, and Spectrum Width), 
one at a time, from four different perspectives provided in each panel. 
These perspectives are:

• Upper Left - The Plan Position Indicator (PPI), or constant vertical elevation 
angle, Panel;

• Upper Right - The Constant Altitude Plan Position Indicator (CAPPI) Panel;

• Lower Left - The Vertical Dynamic Cross Section (VDX) Panel; and

• Lower Right - The Three-Dimensional Flier (3DF) Panel.

These different panels provide forecasters vantage points for analyz-
ing base radar data that are unavailable anywhere else in the D-2D software (3DF) or far more dynamic and/or interactive 
(VDX and CAPPI). FSI also has the benefit of a longer frame count (approximately 2 hours worth of volume data) than is 
available in D-2D. However, FSI is a system resource intensive application that is best used at specific points in the warn-
ing decision-making process. More details on this process will be covered in DLOC Topic 7 (Convective Storm and Evolu-
tion) and Topic 8 (DLOC Workshop).
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B. Loading the FSI Extension from D-2D

The FSI Extension can be launched from within D-2D from 
two different locations:

• The Tools menu or

• The “Applications” section of any radar menu.

Regardless of which menu you use, there is a process you 
will want to follow prior to launching the application. First, 
you should load a Base Reflectivity or a velocity/reflectivity 
combination product in the main display panel. You use the 
products in this panel as a point of reference for which to 
launch the FSI Extension. Generally speaking, when you 
first launch FSI, you will want to identify a specific storm or 
area of storms that you want to interrogate more closely. Once you have identified those storms, then you will load FSI.

After you initially launch the application, you will need to press the Right-Mouse Button in the vicinity of a storm you wish to 
interrogate for the FSI Extension to open. If you forget, the product legend for FSI in the main D-2D display panel provides 
a hint. If your CWA has multiple dedicated radars, you will need to select the radar you want FSI to display at this point.

C. Using the FSI Extension

The FSI Extension displays data from any base moment (including SRM), but the same product appears in all four display 
panels simultaneously. The displays are linked so that when the user toggles a new product, zooms, or pans in one display, 
all of the other displays will update accordingly. Users can toggle between radar base products by using the following key-
board shortcuts from the main typing area of the keyboard (i.e., not the numeric keypad):

• Base Reflectivity - “Z” or “1”;

• Base Velocity - “V” or “2”;

• Storm-Relative Velocity Map (SRM) - “S” or “3”; and
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• Spectrum Width- “W” or “4”.

The following sections provide a brief overview of each display panel, the general uses for both the menu bar and button 
panel items, and some other important points about FSI to know prior to working on WES Exercise 3.

i. The PPI panel

The PPI Panel displays an elevation-based radar product similar to what you’ve seen in the main D-2D window. Users can 
toggle up-and-down in elevation or back-and-forth in time to change the appearance of this display panel using the menu 
bar, button panel, or numeric keypad (more details on how to perform these tasks in Sections v-vii).

In addition to the base moment data, the PPI panel contains the vertical cross-section control tool. This tool is a dashed 
white line with five points that indicate and control the position of the vertical cross-section axis displayed in the VDX panel. 
You can press and hold on one of these points of the cross-section to dynamically adjust the image in the VDX display 
using the following controls:

• The circle at the middle of the cross-section allows the user to adjust the horizontal position of the entire axis;

• The square points at either end of the cross-section allows the user to adjust the end points of cross-section; and

• The square points between the end and center of the cross-section allow the user to rotate the axis around the center point of the line.

Learning how to quickly control both the product toggling and vertical cross-section control tool in this panel is critical for 
forecasters to use FSI effectively.

ii. The CAPPI panel

The CAPPI Panel allows forecasters to quickly visualize base moment data at a constant elevation. FSI allows forecasters 
to display CAPPIs and change their MSL height quickly. To adjust the height above MSL (AGL heights are not available in 
FSI) of the CAPPI, use the blue vertical bar immediately to the right of the display panel.

iii. The VDX panel

The VDX Panel shows a vertical cross-section of base data represented by the vertical cross-section control tool in the PPI 
and 3DF Panels. Changing the location, length, or orientation of the cross-section axis in either of the previously mentioned 
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panels will result in the VDX Panel updating dynamically. In addition to altering the display with the vertical cross-section 
control tool, users can adjust the vertical scale of the cross-section by using the blue vertical bar immediately to the right of 
the display panel.

iv. The 3DF panel

The 3DF Panel plots both the vertical cross-section and either the PPI or CAPPI displays in true 3-D earth coordinates. As 
in the PPI panel, the vertical cross-section tool is visible in the 3DF Panel and can be used to dynamically adjust the display 
in the VDX Panel using the same controls as mentioned previously in the PPI Panel. The 3DF Panel allows forecasters to 
visualize WSR-88D volumetric data on a single display. Novice forecasters who are not familiar with viewing three-dimen-
sional radar visualization products may require some time to become confident at interpreting data using the 3DF Panel.

v. Menu bar

The menu bar contains several menus:

• File - Used primarily for saving current or restoring default settings as well as to exit the FSI extension;

• Navigate - Contains a complete list of traditional volume navigation and some alternative volume browsing hot keys;

• Camera - Contains a list of some alternative display navigation hot keys;

• Options - Contains a list of additional display option hot keys;

• Products - Contains a list of product selection hot keys; 

• Map - Map overlays can be added, hidden, removed, or configured here for all of the display panels; and

• Help - Contains an about screen for FSI.
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vi. Button panel

The Button Panel contains several features that can be accessed by selecting the following buttons:

• Preferences - Used to open the “Edit Preferences” pop-up window;

• Readout (Data Sampling) - Toggles data sampling on/off;

• Snapshot - Opens the “Take Snapshot” pop-up window to make image captures of your FSI Extension;

• Color Key- Toggles the color key off/on under the FSI Button Panel;

• Loop - Toggles looping on/off (NOTE: Loop preferences are editing using the “Edit Preferences” pop-up window);

• Auto-Update - Toggles automatic radar data updates on/off; 

• Plan View- Resets the viewing angle of the 3DF Panel to the default position;

• Reset - Restores the FSI Extension panels to the initial conditions of when you last launched FSI;

• Back - Steps the display panels back one volume scan while maintaining the current elevation angle;

• Next - Steps the display panels forward one volume scan while maintaining the current elevation angle; 

• Latest - Steps the display panels forward to the current (or latest volume scan available) while maintaining a constant elevation angle; and

• Radar Status Bar - Continuously updating readout showing the date, time, VCP, and elevation angle of the most recently completed eleva-
tion scan from the radar and the product being viewed.

vii. Basic panel controls
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When using the FSI Extension, there are some basic controls you will need to know to use the interface effectively. Some 
of the controls are primarily mouse-based while others primarily use the numeric keypad. The mouse-based controls allow 
the user to control the appearance of the displays at a single point in the volume. These mouse-based control features are:

• Zoom - Press and hold the Middle-Mouse Button while moving the mouse forward (zoom in) or backward (zoom out);

• Pan - Press and hold the Left-Mouse Button while moving the mouse to “pull” the image to the desired location;

• 3D Rotate- Press and hold the Left-Mouse Button and <SHIFT> key while moving the mouse forward (increase viewing angle) or backward 
(decrease viewing angle) to adjust the viewing angle in the 3DF Panel;

Similarly, the numeric keypad is the easiest way to navigate through the radar volumes. These numeric-keypad controls are 
(NOTE: For the following commands to work, you will need to have “Num Lock” toggled on):

• “8” Key - Move up one elevation angle in traditional volume scan;

• “2” Key - Move down one elevation angle in traditional volume scan;

• “4” Key - Move backward one volume scan at constant elevation angle;

• “6” Key - Move forward one volume scan at constant elevation angle;

• “9” Key - Move up one elevation angle in virtual volume scan; 

• “3” Key - Move down one elevation angle in virtual volume scan; and

• “.” Key - Toggle between Reflectivity and Storm-Relative Velocity Map products.
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D. Other Important Issues with FSI

In addition to all of the previous features and controls discussed, there 
are a handful of other important items to mention related to FSI. These 
items are:

i. Interpolation

FSI allows users to toggle on data interpolation for the CAPPI, VDX, 
and 3DF panels. This interpolation feature is turned on by default. Inter-
polation can be toggled using the “I” keyboard shortcut or by using the 
Options Menu. More on the interpolation feature will be discussed in 
WES Exercise #3.

ii. City name labels

FSI allows the user to add various map overlays to all of the display 
panels. One of these overlays (Cities --> NAME) has been shown to 
severely limit the performance of FSI. It is recommended that you don’t 
plot this overlay in FSI.
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iii. Using triangles for more accurate sampling

While you have to ability to toggle sampling on, the accuracy of that 
sampling will vary depending on one of your settings in the “Edit Pref-
erences” window. That setting, called “Use Triangles over Textures” 
(found under Advanced Settings --> Display --> OpenGL), will result in 
more accurate sampling when turned on. However, there is a signifi-
cant reduction in performance when this option is turned on. More on 
this issue with sampling will be discussed in WES Exercise 3.



Warning Decision Training Branch

Lesson 9: WarnGen Basics

Radar & Warning Applications in AWIPS

1 - 93

Lesson 9: WarnGen Basics
This lesson provides some background information on WarnGen. While this lesson presents basic instructions, more 
details and examples are available in WES Exercise 4 (WarnGen).

A. Setting Up the Main Display Panel Prior to Loading WarnGen

The primary tool in AWIPS for issuing short-term, text-based warnings is the application called WarnGen. WarnGen profi-
ciency is critical to support effective warning operations.

Prior to using WarnGen, you should configure a display panel in one of your D-2D windows to use in conjunction with Warn-
Gen. In this display panel, you want to load useful product(s), significant maps, and the optimal number of frames prior to 
starting WarnGen. Having the wrong ones can cost precious time. Your office may already have a procedure bundle 
designed for loading products and maps into the main display panel prior to launching WarnGen. Whether you do or not, 
here are some important (but not all-inclusive) practices to know about setting up such a panel.

i. Keep the frame count at or below the default frame count of 12.

Six to ten frames is better, but you definitely want to have twelve or less frames.

ii. Load the products (and maps) in the display panel used to generate the warning.

For many short-fuse warning situations, the product is a 0.5o Base Reflectivity and a Storm Relative Mean Velocity Map (or 
Base Velocity) combination product.

iii. Do not use an all tilts or four-panel products in the same display panel with WarnGen.

iv. Try not to clutter the display with extra maps or products.

If you think you may need certain products on the display in the future, consider loading the maps/products and then tog-
gling them off so that they are not a distraction. Better yet, have the additional products in a separate display panel that you 
can monitor in the same D-2D window. The WarnGen display has one, and only one, purpose: To support issuing warnings.
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v. Develop two-handed proficiency with the WarnGen storm motion tool.

When generating most warnings, you will need to determine a storm motion with WarnGen. To become faster at using 
WarnGen, practice determining the storm motion using both hands (i.e., one hand using the mouse to move the feature 
tracker and the other hand using the arrow keys to step through the frames). With a little practice, you will become signifi-
cantly faster at determining storm motion if you are proficient at using both hands in the process.

B. Starting WarnGen and Using the WarnGen GUI

The WarnGen application can be used with 
any D-2D window and can be run on multiple 
displays simultaneously. The button that 
launches WarnGen is bright yellow and 
located in the upper right-hand side of the D-
2D window.

Once WarnGen is started, the WarnGen storm 
centroid marker appears in the center of the 
main display panel and the WarnGen GUI will 
appear in a separate window. 

The storm centroid marker functions similarly 
to the Distance Speed tool in the Tools menu. 
Move the marker to the storm centroid, hook 
echo, or other trackable feature on both the 
last frame and a previous frame in the loop to 
generate a storm motion vector. In addition to 
the storm motion vector, a hatched polygon 
appears. This enclosed, hatched area repre-
sents the area included in the warning.

The WarnGen Dialog box provides the ability 
to easily customize several components of the 
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warning (or follow-up product). From this interface, the user can choose many details including the type of warning, the 
duration of the warning, and customized statements specific to the current threat. After using the WarnGen GUI to custom-
ize the warning details for the current storm (or threat), the user creates the actual warning text by clicking the “Create Text” 
button at the bottom of the GUI.

Task: Starting WarnGen and Generating a Storm Motion Vector

This task demonstrates the basic steps of starting WarnGen in a D-2D window and using the storm centroid marker to generate a storm 
motion vector and warning polygon. While this task is designed to be performed on an operational AWIPS workstation, it is highly rec-
ommended that you only try these steps on a WES workstation or on an AWIPS workstation set to practice mode in coordination 
with your local training officer. Other WarnGen exercises are also available for use on your local WES machine using WES Exercise 
4.

Additional Assumptions:
• That you have changed D-2D to practice mode for this exercise.

1.0. Select the WarnGen Button and Press the Left-Mouse Button.

2.0. Use the Storm Centroid Marker Tool to Determine the Storm Motion Vector.

2.1. Select the “Drag me to Storm” marker and press & hold the Left-Mouse Button.

2.2. Move the marker to the feature you want to track and release the Left-Mouse Button.

2.3. Step back several volume scans in the main display panel using either the arrow keys or the buttons in the toolbar.

2.4. Again, select the feature marker and press & hold the Left-Mouse Button.

2.5. Move the marker over the same feature you originally tracked in Step 2.2 and release the Left-Mouse Button
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2.6. Review several frames of the loop forward and backward in time to ensure that the storm motion vector is accurate for 
the storm feature you are tracking.
• If the track is not satisfactory, keep repeating steps 2.1 through 2.5 to refine the storm motion vector.

• Depending on the feature you are tracking, this process can sometimes take several iterations before obtaining an accurate estimate.

• This vector is critical for the warning polygon and the warning text to be accurate!

3.0. Task Complete!

C. Customizing Your Warning Polygon

Besides determining the storm’s motion for the warning and using the WarnGen GUI to configure important elements of 
your warning product, the other step you will normally perform prior to creating your warning text is to adjust the shape of 
your warning polygon. The following are the most critical tasks to perform when altering the shape of your WarnGen poly-
gon from its default state.

i. Redraw polygon based on storm track

After you determine a storm motion using WarnGen, you will 
first want to redraw the polygon to fit the new storm track. The 
easiest way to do this task is to use one of the “Redraw Box on Screen” buttons in the WarnGen GUI. After creating the 
storm track, select the “Track” button in the section of the GUI to redraw a default warning polygon oriented along the storm 
motion track and containing the storm centroid dot for the most recent volume scan available in the main D-2D display. 
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ii. Moving vertex points

In most instances, you will only need to customize your warn-
ing polygon by moving the default vertex points to cover a 
larger, smaller, or different area. The vertices can be moved 
with a simple “click and drag” action using the Left Mouse But-
ton. The warning polygon, including stippling, will update auto-
matically.

When reshaping your warning polygon in this manner, remem-
ber to include all areas that are at risk of experiencing severe 
weather covered by that warning type. In the case of a single 
tornado warning issued for a storm, make sure the warning 
polygon includes the tornado risk area as well as any areas at 
risk for severe hail or straight-line winds, too. In general, when 
unsure of how to draw a warning polygon, it’s better to make it a little bit bigger than a little bit smaller.

Additionally, if you are warning for a storm where there is significant uncertainty as to the storm motion track, account for 
that uncertainty in your warning polygon by making the line segment at the far end (i.e., farthest from the storm) of your 
warning polygon longer than the line segment at the beginning (i.e., nearest to the storm) to incorporate that uncertainty 
into your warning.

iii. Adding or removing vertex points

There will be some occasions where you will want to add vertices to your warning polygon. Most often, these situations will 
involve line warnings with bowing segments or single storm warnings where you want to account for storm motion uncer-
tainty or multiple threat areas that may have differing storm motions. 

New vertices are added to the warning polygon using a context relative menu accessed by selecting the warning polygon 
line segments with a Right Mouse Button “click and hold”. In the menu that appears, just select the “add vertex” option to 
add a new point to the warning polygon. Make sure, when using this feature, that you select the line segment in the warning 
where you want to add the additional vertex. After selecting this option, you will see a new vertex linked to the cursor. Just 
press your Left Mouse Button at the location you desire for the new vertex and the new point is located there.
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Vertex points are removed from the warning polygon using the same context relative menu. Instead of selecting a line seg-
ment, you select the vertex you wish to remove and then “click and hold” with the Right Mouse Button. In the menu that 
appears, select “remove vertex” to remove the point from the warning polygon. Generally speaking, you should always 
have at least four points in your warning polygon. So, you should only remove a vertex if you are at a point after you have 
already added one to your warning polygon.

iv. Restoring polygon to default configuration

When you are customizing a polygon in WarnGen, speed is critical. Everyone, even veteran warning forecasters, will occa-
sionally draw a warning polygon one way and then realize, prior to sending the warning, that they want to draw the warning 
boundaries differently. Depending on the complexity of the changes you make to a warning polygon, sometimes it’s faster 
to just start over from scratch. The easiest way to proceed, especially if you are still comfortable with the storm motion, is to 
select the “Track” button from the “Redraw Box on Screen from” section of the WarnGen GUI.

D. Using the Text Window

Using the customized settings in the WarnGen GUI, WarnGen trans-
lates the information into a text product that is displayed in a text 
window on the Text Display. The auto-generated text contains the 
storm speed and direction, the counties and cities affected by the 
warning/advisory, the valid times of the product, the warning/advi-
sory body text (including any optional bullets selected in the GUI), 
and additional code to help our partners to efficiently process and 
disseminate the warning/advisory. The text appears in an editor win-
dow for final review before issuance.

NOTE: Edits made to product text in the editor window should be 
limited to items such as forecaster name/initials, call-to-action text, 
etc. If changes are warranted for items such as storm motion, 
warned counties, or Latitude/Longitude points, close the editor win-
dow and make changes using the D-2D and WarnGen graphical 
tools, then recreate the text.
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Lesson 10: Displaying Text Products in a Text Window
This lesson provides instructions on how to use AWIPS text windows to display a variety of text products. These products 
can be alphanumeric radar products generated by the WSR-88D or any of the text products generated by a WFO that are 
currently in the local database.

A. Displaying Alphanumeric RPG Products

While most products generated by the WSR-88D Radar Product Generator (RPG) can be displayed as graphical or image 
products in D-2D, some products contain textual information designed for display in a text window. These products are 
often referred to as Alphanumeric RPG Products. Some of these products are simply text products (e.g., Free Text Mes-
sage) while others contain textual information embedded within a graphic product and can only be displayed in a text win-
dow (e.g., adaptable parameters of the Tornado Vortex Signature). Either way, to display this information you need to know 
which products can be viewed in a text window and how to do so.

Here is a list of the different alphanumeric RPG products you can view in a text window (including the three letter identifier 
for that product):

Alphanumeric RPG Products That Are Viewable in a Text Window
Product Name Three-Letter Identifier
Free Text Message FTM

Hail Index HAI

Mesocyclone MES

One Hour Precipitation OHP

One Hour Snow Depth OSD

One Hour Snow Water Equivalent OSW

Product List PTL

Radar Coded Message RCM
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The steps for displaying these products are shown in the following task that covers how to view an STI product.

Task: Loading the Alphanumeric Information for a STI Product

This task demonstrates how to use a text window to access the attribute and adaptable parameter information embedded within a STI 
product.

Storm Structure SST

Storm Total Precipitation STP

Storm Total Snow Depth SSD

Storm Total Snow Water Equivalent SSW

Storm Track Information STI

Supplemental Precipitation Data SPD

Three Hour Precipitation THP

Tornado Vortex Signature TVS

User Alert Message USM

User Selectable Snow Depth USD

User Selectable Snow Water Equivalent USW

VAD Wind Profile VWP

Alphanumeric RPG Products That Are Viewable in a Text Window
Product Name Three-Letter Identifier
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Additional Assumptions:
• The AWIPS database of radar products currently contains a STI product.

1.0. Choose an Open Text Window (or Open a New Text 
Window) on the AWIPS Workstation.

2.0. In the “AFOS Cmd:” Text Field, Enter the Follow-
ing Text: “WSRSTIXXX”, Where XXX is the Last 
Three Letters of the RPG ID and Press the <Enter> 
key.
• Request any desired RPG alphanumeric products in a similar 

fashion.

• Swap “STI” with the three-letter identifier for the desired alpha-
numeric product.

• Alphanumeric products from other radars in your local AWIPS 
database are obtained by switching the last three letters to a dif-
ferent RPG ID.

3.0. Task Complete!



Radar & Warning Applications in AWIPSWarning Decision Training Branch

1 - 102Lesson 10: Displaying Text Products in a Text Window

B. Displaying Office Text Products

In addition to RPG alphanumeric products, the AWIPS text 
window can display any text product currently in the AWIPS 
database. These products may be issued by your local 
office or by neighboring offices which are pertinent to your 
operations.

There are several ways to access these products in a text 
window. Like RPG alphanumeric products, the nine-letter 
ID for a product in the “AFOS Cmd:” entry field retrieves all 
instances of that product from the database. Alternatively, 
the AFOS Browser provides a GUI used to select the Node, 
Category, and Designator from menus that construct the 
nine-letter ID for a text product. The AFOS Browser is par-
ticularly useful for loading less common products. Lastly, 
you can use the Load History to open text products that have been viewed previously on that AWIPS workstation.

Task: Using the AFOS Browser to Load an Area Forecast Discussion

This task demonstrates the steps for using the AFOS Browser to view an Area Forecast Discussion (AFD) from your local office 
AWIPS database.

Additional Assumptions:
• There is currently an AFD product in your local AWIPS database.

1.0. Select an Open Text Window (or Open a New Text Window) on the AWIPS Workstation.

2.0. Select the “AFOS Browser” Button from the Text Window Toolbar and Press the Left-Mouse Button.
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3.0. Select the Product from the AFOS Browser

3.1. In the AFOS Browser, select the Node from the first menu for the 
product you want to display and press the Left-Mouse Button.

3.2. In the second menu, select the Product Category for the product you 
want to display and press the Left-Mouse Button.

3.3. In the third menu, select the Office Designator for the product you 
want to display and press the Left-Mouse Button.

3.4. Select the “Load and Close” button (or the “Load and Continue” 
button if you want to load other text products after this example) and 
press the Left-Mouse Button.

4.0. Task Complete!
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Lesson 11: Requesting Non-Standard Products from an RPG
This lesson provides instructions on how to use One-Time Requests (OTRs) and Radar Multiple Requests (RMRs) to 
request products that do not normally appear in your local AWIPS database. These may be products that are not routinely 
sent by your dedicated RPG(s) or products from surrounding RPGs that your office receives via dial-up connections rather 
than the AWIPS SBN.

A. One-Time Requests (OTRs)

Sometimes an AWIPS operator needs to access product(s) not included on 
your Routine Product Set (RPS) list, not from one of your dedicated radars, 
and/or in the AWIPS SBN data feed. When only a single product is needed 
for a short period of time, or when the product request requires user input 
that might change from one request to another, then an OTR is the best way 
to request that product from an RPG. 

An OTR can only request a single product from a single RPG with each 
request, but it can request multiple instances of a product over several Vol-
ume Scans (up to nine total). Products that are typically requested using an 
OTR include Reflectivity and Velocity Cross-Sections and Clutter Bypass 
Maps.

Task: Submit an OTR for a Radar Cross-Section (RCS) Product

This task demonstrates how to use an OTR to request a RCS product for a radar that covers part of your CWA. Operationally, you 
would likely only perform this task for a non-dedicated radar that best covers a portion of your CWA (i.e., normally you would use FSI 
to view a radar cross-section). For this example, you can choose to use a dedicated or non-dedicated radar to request a RCS product. 
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NOTE: This process is applicable to both RCS and VCS (i.e., Velocity Cross-Section) products, even though only an RCS is covered in 
these instructions.

Additional Assumptions:
• None

1.0. Determine the Baseline for the RCS Product

1.1. Load a 0.5o Reflectivity product (or a Composite Reflectivity product if 
the situation warrants) in the main display panel.

1.1.1. Select a menu for a dedicated radar that gives you the best view of 
the region you want to generate a cross-section for and press the 
Left-Mouse Button.

1.1.2. In the menu that appears, select “kxxx Best Res Refl” (where kxxx 
is the menu you originally selected) and press the Left-Mouse But-
ton.

1.1.3. In the submenu that appears, select “0.5 Ref” and press the Left-
Mouse Button.

1.2. Position the baseline used to generate the cross-section.

1.2.1. Select the Tools menu and press the Left-Mouse Button.

1.2.2. In the menu that appears, select “Baselines” and press the Left-Mouse Button.
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1.2.3. In the main display panel, position one of the baselines that appear where you want 
a RCS product to be generated.

• The baseline end points must be located between 0.5 and 124 nm from the RDA of the radar from which you 
want to generate the cross-section.

• The baseline must be less than 124 nm in length.

1.2.4. Note the baseline ID (labeled A through J) used in Step 1.2.3.

1.3. Position the cursor in one of the side display panels and press the Right-Mouse Button to 
swap panes.

2.0. Open the OTR GUI

2.1. Select a menu for a dedicated radar or the Radar menu from the D-2D toolbar and press the 
Left-Mouse Button.

2.2. In the menu that appears, select “One time request...” and press the Left-Mouse Button.

3.0. Select the Parameters and Submit Your OTR.
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3.1. Set the Repeat count

3.1.1. Select the Repeat count pull-down menu and press & hold the Left-Mouse 
Button.

3.1.2. Choose the number of products (up to 9) you want to request from the RPG 
and release the Left-Mouse Button.

3.2. Select the RPG

3.2.1. Select the RPG pull-down menu and press & hold the Left-Mouse Button.

3.2.2. Choose the RPG ID for the desired radar and release the Left-Mouse But-
ton.

3.3. Select RCS Product

3.3.1. Select the Product pull-down menu and press & hold the Left-Mouse But-
ton.

3.3.2. Choose the “Ref X-Sect (RCS)” product and release the Left-Mouse Button.

3.4. Select the Baseline

3.4.1. Select the Baseline pull-down menu and press & hold the Left-Mouse Button.

3.4.2. Choose the baseline you edited in the main display panel (in Step 1.2) and release the Left-Mouse Button.

3.5. Select the “Send” button and press the Left-Mouse Button.
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4.0. Display the RCS Product

4.1. Select the radar menu (i.e., kxxx or Radar) for the RPG you submitted 
the OTR and press the Left-Mouse Button.

4.2. In the menu that appears, select “kxxx Derived” (where kxxx is the menu 
you originally selected) and press the Left-Mouse Button.

4.3. In the submenu that appears, select “Reflectivity (RCS)” and press the 
Left-Mouse Button.

5.0. Task Complete!

B. Radar Multiple Requests (RMRs)

When an AWIPS operator requires non-standard products from their dedicated RPG(s), or products not found in the normal 
AWIPS SBN feed from a non-dedicated RPG, then a RMR is usually used to request that data. The RMR application allows 
the AWIPS operator to automate up to eight hours of non-routine radar products, including multiple RPGs and products. 
These requests are saved and can be resubmitted by other AWIPS operators in the future.

NOTE: When working with RMRs, unless creating a new or manipulating an existing RMR, the only buttons you need to 
use are the “Submit” button in the top and the “Cancel” button in the bottom of the RMR GUI.

Task: Opening the RMR GUI

This task demonstrates how to open the RMR GUI. Subsequent tasks demonstrate specific features of the RMR GUI.

Additional Assumptions:
• None
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1.0. Select One of the Dedicated Radar Menus (or the Radar Menu) from the D-2D Toolbar and Press 
the Left-Mouse Button.

2.0. In the Menu That Appears, Select “Radar multiple request...” and Press the Left-Mouse Button.

3.0. Task Complete!

i. Creating a new request

While most offices probably have a fairly thorough list of RMRs, situations may arise where you need to create a new 
request. Use the step-by-step GUIs and the “New Request” feature to name the request and add products to the list.

Task: Build a New Request in the RMR GUI

This task demonstrates how to build a new request for non-routine products in the RMR GUI.

Additional Assumptions:
• None

1.0. If the RMR GUI is not Currently Open, Follow the Steps in the Task on “Opening the RMR GUI” to Open the GUI.

2.0. Create a New Request

2.1. In the RMR GUI, select the “New Request...” button and press the Left-Mouse Button.
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2.2. Enter information in the “New Request” GUI

2.2.1. Type a name in the “Name” field.

2.2.2. If this request is a multiple request, enter a request frequency (in the 
“Repeat every”) and a duration (in the “Duration”) fields.

2.2.3. Select the ”OK” button and press the Left-Mouse Button.

3.0. Add Products to the New Request

3.1. Select the Radar Type

3.1.1. Select the Radar Type pull-down menu and press & hold the Left-Mouse 
Button.

3.1.2. Choose the radar type and release the Left-Mouse Button.

3.2. Select the radar from either the Dial Out or Dedicated RPGs listing and press 
the Left-Mouse Button.

3.3. Select the Product

3.3.1. Select the Product pull-down menu and press & hold the Left-Mouse But-
ton.

3.3.2. Choose a product from the list and release the Left-Mouse Button.

3.4. Set the Request Interval and other necessary parameters (i.e., Elevation, Data 
Levels, and Resolution) for the requested product.

3.5. Select the “Add” button and press the Left-Mouse Button.
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3.6. Repeat Steps 3.1 through 3.5 for any other products you wish to add to the RMR.

4.0. Select the “Close” Button and Press the Left-Mouse Button to Close the Window.

5.0. Task Complete!

Sometimes, you may wish to edit an existing RMR. For example, you may need to adjust a recently made RMR or you may 
wish to add some newly developed products to the list.

ii. Submit an existing request

Once you have a RMR product listing, you can submit the request whenever you desire to receive those products. A RMR 
can be submitted even when other RMRs are currently active. After the request is submitted, it appears in the “Active 
Request” panel of the RMR application.

Task: Submit an Existing Request to the List of Active Requests

This task demonstrates how to submit an existing RMR to the Active Request list.

Additional Assumptions:
• That there is currently at least one existing RMR ready to submit.



Warning Decision Training Branch

Lesson 11: Requesting Non-Standard Products from an RPG

Radar & Warning Applications in AWIPS

1 - 113

1.0. If the RMR GUI is not Currently Open, Follow the Steps in the 
Task on “Opening the RMR GUI” to Open the GUI.

2.0. In the RMR GUI, Select a Request from the Existing Requests 
Listing and Press the Left-Mouse Button.

3.0. Select the “Submit” Button and Press the Left-Mouse Button.
• The request should now appear in the Active Requests panel.

• You should monitor the Request Queue and be prepared to take action if 
either of the percentages exceeds 100% (see below).

4.0. Task Complete!

iii. Monitoring RMR activity

While RMRs provide users a more powerful option to receive data than an OTR, it comes 
with an added risk. It is possible to request too much data using the RMR application. 
When this happens, the data will still be requested, but the system will warn the AWIPS 
operator that the requested products may not be received in a timely fashion. Conse-
quently, another important aspect of the RMR application is the ability to monitor active 
requests and remove requests from the RMR Queue.

When monitoring activity in the RMR application, it’s important to keep an eye on the Dial 
Out and Dedicated RMR Queue percentages. When these percentages exceed 100%, 
the RMR application error message is triggered. The RMR application provides an addi-
tional cue by changing the small color signal next to the “RMR Queue” label from green 
to red when one of the percentages exceeds 100%.

NOTE: Even if the Queue percentage exceeds 100%, you may not experience a drop in performance or a data slow down. 
In some cases, you may notice a percentage of over 300% and not experience any issues with your RMR. However, when 
the percentage exceeds 100% you need to be aware that problems may occur with your RMR.
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Task: Removing a Request from the RMR Queue

This task demonstrates how to remove a request from the Active Request Panel.

Additional Assumptions:
• There is at least one active RMR.

1.0. If the RMR GUI is not Currently Open, Follow the Instructions in 
the Task on “Opening the RMR GUI” to open the GUI.

2.0. In the Active Request Panel, Select a Request You Want to Remove 
and Press the Left-Mouse Button.

3.0. Select the “Cancel” Button and Press the Left-Mouse Button.

4.0. Task Complete!
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Lesson 12: Flash Flood Monitoring and Prediction (FFMP) Basics
This lesson presents information on the Flash Flood Monitoring and Prediction (FFMP) application. While this lesson pres-
ents the basics, more detailed tasks and examples are included in WES Exercise 5 (Flash Flood Monitoring and Prediction) 
on your local WES machine.

A. About FFMP

The Flash Flood Monitoring and Prediction system is an integrated suite of 
multi-sensor applications that detects, analyzes, and monitors precipitation 
and generates short-term warning guidance for flash flooding automatically 
within AWIPS. FFMP conducts its precipitation analyses on a basin-scale, 
meaning that all of the calculations are done over the area of a drainage 
basin. Because of its ability to combine multiple measurements of observed 
rainfall with flash-flood guidance on a basin-level, into a single interface that 
the AWIPS operator can monitor, being proficient in using FFMP can signifi-
cantly enhance operator efficiency in warning operations.

B. Starting FFMP

All of the FFMP product suite products are available underneath the SCAN 
menu in D-2D. All the FFMP products are grouped together in the “FFMP” 
section and they are grouped together by quantitative precipitation estimate 
(QPE) input source. FFMP can be configured to use any of your WFOs dedi-
cated radars as a QPE source or a gridded, multi-sensor QPE source that is 
defined by AWIPS configuration files. The standard gridded, multi-sensor QPE source for FFMP is the HPE.

After selecting the “FFMP Image/Basin Table” product, FFMP displays a GUI, called the FFMP Basin Table, and an interac-
tive image in the main display panel of D-2D. It may take several moments for FFMP to load as it creates the Basin Table 
GUI. If no data are available to display, the AWIPS operator is informed that FFMP will not load.
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Task: Loading the FFMP Basin Table

This task demonstrates how to load the FFMP Basin Table in D-2D in preparation for using the GUI. Besides this simple task descrip-
tion, several other sample tasks can be performed on your office’s WES workstation in the WES Exercise 5 (distributed with your 
DLOC Student Guides) on your local WES machine. Practicing those exercises will result in a more thorough understanding of how 
FFMP works.

Assumptions:
• None

1.0. Select the SCAN Menu in the D-2D Display and Press the Left-Mouse Button.

2.0. In the Menu That Appears, Select the “FFMP kxxx Display” for a Particular Radar and Press the Left-Mouse Button.

3.0. Task Complete!

C. The FFMP Basin Table

The FFMP Basin Table contains comprehensive data on all the drainage basins in your CWA at multiple spatial scales. 
Many options are available in this GUI. Time and practice are required for the novice operator to become familiar with all of 
the functionality.

The GUI is divided into five different sections, each discussed below.
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i. Menu bar

The Menu bar contains numerous menu buttons that allow users to 
access many functions and features in FFMP. It may take novice 
users some time to become familiar with all of the features located 
under these menus. Here is a brief description of each menu:

• File - Used primarily to save or retrieve FFMP configuration settings.

• Config - Allows users to change the FFMP configuration settings for Link to 
Frame (i.e., time matching between FFMP Basin Table and main D-2D dis-
play), Worst Case (aggregate FFMP data will show worst case data vs. aver-
age), and Auto-Refresh.

• D2D - Changes what attribute is used to fill county and basin level plots in the 
main D-2D display.

• Layer - Allows users to change how FFMP Basin Table and Color Image 
aggregate (i.e., average) data.

• Zoom - Changes settings for how FFMP Basin Table and Color Image 
behave when a user selects a county in the Basin Table.

• CWA - Allows users to trim the Basin Table and Color Image down to only counties and basins in a particular CWA.

• Click - Configures interactivity available to users when they click on the Color Image in the main D-2D display.

ii. Utility bar

The Utility bar contains two buttons (Refresh D2D and Config Summary) and the date and time for the currently displayed 
data. Each time you change a display setting in the FFMP Basin Table, unless auto-refresh is turned on, you will need to 
select the “Refresh D2D” button to update the Color Image in the D-2D main display. By selecting the “Config Summary” 
button, you display a pop-up window with the current settings for several configuration settings in FFMP.
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iii. Timing Section

The Timing section of the FFMP Basin Table allows users to configure and access information about the time duration of 
data being displayed in the Table Body and Color Image. The Time Duration slider bar allows users to choose the time win-
dow to be displayed in 15 minute increments. The “Gap” value indicates the cumulative amount of time (in hours) that data 
are not available for the specified duration window. Lastly, the “Rate” button toggles on/off the display of instantaneous pre-
cipitation rate information (i.e., Time Duration = 0 hrs) in the Color Image display.

iv. Attribute column titles

The attribute column titles are the labels designating which attributes are displayed in the Table Body. Selecting the Title of 
an attribute sorts the data in the Table Body by that column. If a county’s or basin’s data for that attribute falls below a pre-
defined “Filter” value, that county or basin will not be displayed in the Table Body. The “Filter” value, as well as other thresh-
old values used to color code the data in the Basin Table, can be accessed and/or edited in the Attribute Threshold GUI. 
This GUI is accessible for each attribute, except flash flood guidance, by selecting an attribute column title with a Right 
Mouse Click.

FFMP allows the user to configure the attributes displayed in the Table Body by using the Attribute Inclusion GUI. 
This window is accessed by selecting the small khaki arrow button to the right of all the Table Body column titles.

v. The Table Body

FFMP lists the precipitation and flash flood guidance data for each drainage basin in the Table Body. If there is no rainfall 
over all the geographic entities for the specified precipitation data source and time duration, the table indicates “NA”. The 
D-2D display is linked to the table. After pressing the Left-Mouse Button on an identifier in the “area_Id” column of the Table 
Body, D-2D zooms and re-centers on that particular county or basin and places an “X” at the centroid of that geographic 
region.
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Lesson 13: System for Convection Analysis and Nowcasting (SCAN)
This lesson presents information on the System for Convection Analysis and Nowcasting (SCAN) application. While this 
lesson presents the basics, more detailed examples are included in WES Exercise 6 on your local WES machine.

A. About SCAN

The System for Convection Analysis and Nowcasting (SCAN) is an applica-
tion that integrates data from multiple input sources to generate algorithm 
output and help forecasters detect, analyze, and monitor convective storms 
within AWIPS. SCAN algorithms provide deterministic and probabilistic infor-
mation on storms in their area to supplement standard base radar product 
and environmental parameter data interrogation. SCAN’s automated event 
monitoring was developed to assist forecasters in increasing warning lead 
times, reduce missed events, increase forecaster situational awareness, and 
reduce forecaster fatigue during warning situations.

For novice forecasters, SCAN should be used with caution. The SCAN Storm 
Cell Table and Display provide extensive information on numerous storms 
that can be difficult for experienced forecasters to integrate into their warning 
decision-making process. If not configured properly (i.e., if the default set-
tings are used), SCAN can overstimulate a novice forecaster’s visual and 
auditory senses with its flashing cells and beeping alarms. Generally speaking, there are two areas where SCAN has been 
found to be useful for proficient warning forecasters who incorporate it into their warning decision-making process: For 
looking at storm trend graphs and as a “safety net”. More will be said on these subjects in Section C of this lesson.
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B. Starting SCAN

All SCAN products (including the Storm Cell Table and Display) are loaded from the SCAN menu 
in D-2D. All SCAN products are grouped together by radar input source. For the two uses dis-
cussed in Section A (viewing storm cell trends and using SCAN as a “safety net”), load the 
“Storm Cells/Site Storm Threat” menu option for your radar of interest. Loading this product will 
display the SCAN Storm Cell Table (in a separate window) and Display (in the main D-2D display 
panel). When loading this product, you will likely want to load a base reflectivity (or even a com-
posite reflectivity) product into this same display to better visualize what storms SCAN is trigger-
ing on at a given time.

If your CWA has multiple dedicated radars that provide optimal coverage of certain areas, you 
will need to be careful which radar source you use for loading SCAN. You don’t want to load mul-
tiple instances of SCAN, so you will need to have an idea of your primary threat areas and use 
that information to decide which dedicated radar works best for the situation on that day.

C. Using SCAN

Because SCAN can be overwhelming, it’s best to start slowly. It’s best for novice forecasters to 
focus on the most commonly performed tasks in SCAN. Learning these tasks will help you 
decide how you might want to integrate a tool like SCAN into your decision-making process. 

Recent user surveys by the NWS Meteorological Decision Laboratory (MDL) suggest that the most common uses for 
SCAN are to: 

• Analyze storm cell trend graphs for various storm-based parameters and

• Use the SCAN Storm Cell Table and Display as a “safety net” to alert forecasters about strong (or rapidly developing) storms that may have 
escaped their detection previously.

The following sections will discuss each of these tasks.
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i. Storm cell trends

SCAN allows users to create cell trend graphs for any storm ID in the SCAN Storm Cell Table 
by selecting the ID with the Right Mouse Button. These trends display in a stand alone window, 
with the exact trends included depending on your current configuration settings. Use the “Con-
figurations” button in the SCAN Storm Cell Table to either change the active trend set (Trend 
Sets --> Define Active Trend Set) or to create/edit a trend set (Trend Sets --> Create/Edit Trend 
Set). If you change the active trend set, you will need to reload any desired cell trend sets to 
see the update information.

When using SCAN cell trends, it’s important to understand what information is being shown in 
the cell trends. Until you get familiar with a particular trend set, make sure to routinely double-
check the parameter name in each cell trend. The parameters plotted here are the same data 
that appear in the SCAN Storm Cell Table. If you are unsure of exactly which parameters are 
included in a current trend set, positioning your cursor over the trend set name will show a pop-
up “hint” box with a list of all the parameters included in that trend set. This feature can be very 
helpful in differentiating between some trend sets with similar names (e.g., “base” and “base1”).

An additional feature, which can be seen in the graphic to the right, is that height-based cell 
trend windows include graphical information about the elevation angles available for the current 
volume scan. These graphics provide qualitative feedback about how the height-based data 
compare to the altitude of the radar beams at that time and location.

ii. SCAN as a “safety net”

Many forecasters who utilize SCAN primarily use it as a “safety net”. 
They load the SCAN Storm Cell Table and Display into a D-2D panel 
and check the table and display occasionally to ensure there are not 
any storms approaching warning-criteria that have escaped their attention. If a storm they have not been monitoring 
appears at the top of the table list, has been identified as having a TVS when tornadoes were not considered a primary 
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threat, etc., then the WFO staff will start investigating the base radar and environmental parameter data for that storm in 
greater detail.

The exact parameters and/or thresholds you use for this type of SCAN use will vary greatly from office to office, or even 
from forecaster to forecaster. If you do plan on using SCAN in this manner, you will want to customize the “CELL Alarm 
Thresholds” to ensure that any SCAN alarms that trigger are significant for your usage. We also suggest that, if it is turned 
on, that you turn off the “Bell” so that the SCAN alarms are not audible (and do not irritate your co-workers). Whether or not 
you use SCAN in this manner, your need for the “safety net” should decrease as you gain more expertise working convec-
tive, severe-weather events. 
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Lesson 14: Radar-Related Products in the Volume Browser and Integrated 
Radar Environmental Sampling

This lesson provides instructions on how to use the AWIPS Volume menu to display radar data and environmental parame-
ters that can assist in your storm interrogation and analysis. Some products (i.e., Vertical Wind Profile hodographs and 
radar cross-sections) are displayed using the Volume Browser. Other products (i.e., the Integrated Environmental Sampling 
and Popup Skew-T) are tools that allow forecasters to view vertically oriented, environmental parameter data in conjunction 
with radar data. More details on these later tools can be found in WES Exercise 7 (Integrated Radar Environmental Sam-
pling) on your local WES machine.

A. Vertical Wind Profile (VWP) Hodographs

VWP Hodographs are generated using the Volume Browser. These hodo-
graphs are displayed on a Skew-T graphic in a D-2D pane and can be aug-
mented with various model soundings that are time-matched to the VWP 
observations. 

Because this product is only available via the Volume Browser, the cursor 
Home location must be located at the radar site for which you want to gener-
ate the VWP, and the map scale in the main display panel must be set to 
WFO or State scale.
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Task: Load a VWP Hodograph

This task demonstrates the basic steps for loading a VWP Hodograph using the Volume Browser.

Additional Assumptions:
• That there are data in the AWIPS database for the site you wish to display.

1.0. Set Cursor Home to a Radar Location

1.1. Select the Tools menu and press the Left-Mouse Button.

1.2. In the menu that appears, select “Put home cursor...” and press the Left-Mouse Button.
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1.3. Use the Put Home Cursor GUI to move cursor Home.

1.3.1. In the “Location selection via:” panel, select the check box next to “Station”.

1.3.2. In the Put Home Cursor GUI, type the four-letter identifier for the radar you want 
to display a VWP hodograph for in the “Station” text field.

1.3.3. Select the “Go” button at the bottom of the GUI and press the Left-Mouse Button to 
change the Home location.

1.3.4. Select the “Close” button at the bottom of the GUI and press the Left-Mouse Button 
to close the GUI.

2.0. Move a Point to the Same Location as Cursor Home

2.1. Select the Tools menu and press the Left-Mouse Button.

2.2. In the menu that appears, select “Points” and press the Left-Mouse Button.

2.3. Move a Point to the same position as cursor Home

2.3.1. In the main display panel, select a Point and press & hold the Left-Mouse Button.

2.3.2. Drag the Point to the “x” next to the “Home” label and release the Left-Mouse Button.
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3.0. Use the Volume Browser to Load the VWP Hodograph

3.1. Select the Volume menu in the D-2D toolbar and press the Left-Mouse 
Button.

3.2. In the menu that appears, select “Browser...” and press the Left-Mouse 
Button.

3.3. Use the Volume Browser GUI to load the VWP hodograph.

3.3.1. Change the pull-down menu in the toolbar to “Sounding”.

3.3.2. In the Sources panel, select “VWP” from the Other menu and press 
the Left-Mouse Button.

3.3.3. In the Fields panel, select “Sounding” from the Thermo menu and 
press the Left-Mouse Button.

• Besides “Sounding”, you can also select the “model + Profiler” options under the Thermo menu, where model is the grid source that is used to generate 
the thermodynamic (and fill in gaps in the kinematic) profile.

• When using one of the other options, the profile that is generated from the gridded fields is time-matched to the VWP data.

• Regardless of which Thermo option you choose, the only VWP available in the Planes panel is the one for the Point located at the cursor Home loca-
tion.

3.3.4. In the Planes panel, select the Point (letters A-J) that is located at the same point as cursor Home.

3.3.5. Select the “Load” button and press the Left-Mouse Button.

4.0. Task Complete!

B. Reflectivity and Velocity Cross-Sections
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In addition to VWP hodographs, the AWIPS operator can use the Volume Browser to load a Reflectivity or Velocity Cross-
Section. The benefit to loading a cross-section in this manner is that the cross-section is generated by data already present 
in the AWIPS database. In other words, a One-Time Request for a Reflectivity or Velocity Cross-Section is not necessary to 
display this product.

Task: Load a Reflectivity Cross-Section Using the Volume Browser

This task demonstrates how to use the AWIPS Volume Browser to generate a Reflectivity Cross-Section without submitting a One-
Time Request.

Additional Assumptions:
• None

1.0. Set Cursor Home to Radar Location

1.1. Select the Tools menu and press the Left-Mouse Button.

1.2. In the menu that appears, select “Put home cursor...” and press the Left-Mouse Button.
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1.3. Use the Put Home Cursor GUI to move cursor Home.

1.3.1. In the “Location selection via:” panel, select the check box next to “Station”.

1.3.2. In the Put Home Cursor GUI, type the four-letter identifier for the radar you want 
to display a Cross-Section for in the “Station” text field.

1.3.3. Select the “Go” button at the bottom of the GUI and press the Left-Mouse Button to 
change the Home location.

1.3.4. Select the “Close” button at the bottom of the GUI and press the Left-Mouse Button 
to close the GUI.

2.0. Determine the Baseline for the RCS Product

2.1. Load a 0.5o Reflectivity product (or a Composite Reflectivity product 
may be preferable) in the main display panel.

2.1.1. Select a menu for a dedicated radar that gives you the best view of 
the region you want to generate a cross-section for and press the 
Left-Mouse Button.

2.1.2. In the menu that appears, select “kxxx Best Res Refl” (where kxxx 
is the menu you originally selected) and press the Left-Mouse But-
ton.

2.1.3. In the submenu that appears, select “0.5 Ref” and press the Left-
Mouse Button.

2.2. Position the baseline that will be used to generate the cross-section.

2.2.1. Select the Tools menu and press the Left-Mouse Button.



Warning Decision Training Branch

Lesson 14: Radar-Related Products in the Volume Browser and

Radar & Warning Applications in AWIPS

1 - 129

2.2.2. In the menu that appears, select “Baselines” and press the Left-Mouse Button.

2.2.3. In the main display panel, select one of the baselines that appears and position it where you want a RCS product to 
be generated.

2.2.4. Note which baseline, identified by letters A-J, you positioned for your RCS product.

2.3. Position the cursor in one of the side display panels and press the Right-Mouse Button to swap panes.

3.0. Use the Volume Browser to Load the Reflectivity Cross-Section

3.1. Select the Volume menu in the D-2D toolbar and press the Left-Mouse 
Button.

3.2. In the menu that appears, select “Browser...” and press the Left-Mouse 
Button.

3.3. Use the Volume Browser GUI to load the Reflectivity Cross-Section.

3.3.1. Change the pull-down menu in the toolbar to “Cross-Section”.

3.3.2. In the Sources panel, select “Radar” from the Other menu and 
press the Left-Mouse Button.

3.3.3. In the Fields panel, select “Reflectivity” from the Other menu and 
press the Left-Mouse Button.

3.3.4. In the Planes panel, select the Baseline (labeled A through J) from the “Specified” menu that you positioned previ-
ously.

3.3.5. Select the “Load” button and press the Left-Mouse Button.
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4.0. Task Complete!

C. Standard Environmental Data Package

The Standard Environmental Data Package is one of the integrated radar 
environmental sampling tools in AWIPS. Loading the Standard Environmental 
Data Package from one of the standard model or observational input sources 
results in an invisible overlay for elevation-based radar products. The envi-
ronmental sampling data are listed under the Volume menu in the “Std Env 
Data Package” section. 

The data from this overlay can be accessed using the standard D-2D sam-
pling feature. By default, the environmental data visible via sampling is:

• Wind speed and direction,

• Relative humidity, and

• Temperature.

Other environmental data are also part of the Standard Environmental Data Package, but they are toggled off by default. 
These parameters are:

• Pressure,

• Wet bulb temperature, and

• Equivalent potential temperature.

While these parameters are initially invisible overlays, they can be made visible. By default, the Density for all of these 
overlays is set to 0. By setting the Density to a non-zero value, the overlay contours become visible.
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When using the Standard Environmental Data Package to integrate environmental data with your base radar data analysis, 
it’s important to remember that the data values shown are only valid for the center of the radar beam. When a storm of 
interest is located far from the radar, or there are significant vertical changes in some environmental parameters, then the 
data shown may not accurately represent the environment in the volume that the radar is sampling.

More information on the Standard Environmental Data Package can be found in WES Exercise 7.

D. Pop-Up Skew-T

The other integrated radar environmental sampling tool available in AWIPS is the pop-up 
skew-T window. The skew-T window displays vertical profiles of environmental data at any 
point. The profiles are dynamic and change as you move the cursor around the D-2D dis-
play panel. The vertical profiles show the vertical temperature and dewpoint temperature 
profiles, the height of the current cursor location (indicated by a yellow dot), and the moist 
adiabatic curve for the LFC at that location.

To load the pop-up skew-T window, you need to select the “Popup SkewT” menu item 
from the Volume menu. After performing this task, you will also need to select a data 
source for this application. To select a source, press and hold the Right Mouse Button in 
the background of the main D-2D display panel to access a context sensitive menu. In this 
menu, you’ll need to select the “Sample Cloud Heights/Radar SkewT” submenu and then select a data source from the 
submenu. After performing this step, then the pop-up skewT window will be visible.

When using the pop-up skew-T, it’s possible that the application window gets hidden behind the main D-2D window. To 
avoid this problem, use the application window’s configuration menu (located in the upper left-hand corner of the window) 
and select the “On Top” menu item. Choosing this setting will make sure the pop-up skew-T window is always the top level 
window, even if you are using the main D-2D window. In this way, you can easily analyze the data in both the main D-2D 
window and in the skew-T.

The possible utility of this application is obvious. Users get a snapshot of the vertical environmental profiles while simulta-
neously analyzing radar data. While this application can be quite useful, there is a significant caveat that needs to be taken 
into consideration when using the pop-up skew-T. While the popup skew-T shows the height of the beam center in the win-
dow, it doesn’t provide any indication of the actual beam size at that location. Forecasters should realize, for storms located 
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far away from the radar, that the volume the radar is sampling may be several thousand feet across. In these situations, the 
temperature and dewpoint temperature data at these points in the window may not accurately represent the entire volume 
that the radar is sampling.

More information on the pop-up skew-T can be found in WES Exercise 7.



Warning Decision Training Branch

Lesson 15: AWIPS Keyboard Shortcuts

Radar & Warning Applications in AWIPS

1 - 133

Lesson 15: AWIPS Keyboard Shortcuts
This lesson provides a list of keyboard shortcuts for the D-2D interface, the FSI Extension, and the Text Editor windows.

D-2D File Menu Shortcuts
Shortcut Description
<CTRL>+N Create a new procedure.

<CTRL>+O Open an existing procedure.

<CTRL>+D Delete an existing procedure.

<CTRL>+H Open the History List.

<CTRL>+P Print the contents of the main display panel.

<ALT>+<F4> Close the D-2D window.

D-2D View Menu Shortcuts
Shortcut Description
<CTRL>+C Clear the main display panel.

Step back the contents of the main display one frame at a time.

Step forward the contents of the main display one frame at a time.

<CTRL>+ Display the first frame in the main display panel loop.

<CTRL>+ Display the last frame in the main display panel loop.

<Page Up> First use will cause the frames in the main display panel to loop; subsequent presses will increase the speed of the loop.

<Page Down> First use will cause the frames in the main display panel to loop; subsequent presses will decrease the speed of the 
loop.

D-2D Options Menu Shortcuts
Shortcut Description
<CTRL>+T Toggle time options GUI on.



Radar & Warning Applications in AWIPSWarning Decision Training Branch

1 - 134Lesson 15: AWIPS Keyboard Shortcuts

<CTRL>+S Toggle data scale on.

<Insert> Toggle image combination products on and off.

<CTRL>+L Open the Loop Properties GUI.

<CTRL>+I Open the Image Properties GUI.

D-2D All Tilts Keyboard Shortcuts - Requires an All Tilts Product in the Main Display Panel
Shortcut Description

Step backward the contents of the main display one volume scan at the current elevation angle.

Step forward the contents of the main display one volume scan at the current elevation angle.

Step up the contents of the main display panel to the next highest elevation angle in the database at the current volume 
scan.

Step down the contents of the main display panel to the next lowest elevation angle in the database at the current vol-
ume scan.

D-2D Numeric Keypad Keyboard Shortcuts - For the Numeric Keypad on Right-Hand Side of 
Keyboard Only
Shortcut Description
+ Increase brightness of image product 1, decrease brightness of image product 2 (if loaded).

- Decrease brightness of image product 1, increase brightness of image product 2 (if loaded).

0 Toggle image product loaded in the main display panel on and off.

1-9 Toggle first nine graphic products loaded in the main display panel on and off.

. If image combination is toggled on, and two image products are loaded in the main display, pressing this key will toggle 
between the two image products at full brightness.

<Enter> Toggle between Product Legend, Map Legend, and Timestamp Only Legend.

D-2D Options Menu Shortcuts
Shortcut Description
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FSI Keyboard Shortcuts - For the Main Keyboard Only
Shortcut Description
1 or Z Toggle on Base Reflectivity product displays

2 or V Toggle on Base Velocity product displays

3 or S Toggle on Storm-Relative Mean Velocity Map product displays

4 or W Toggle on Spectrum Width product displays on

<Ctrl> + Display 0.5o elevation product in current volume scan

<Ctrl> + Display most recent elevation angle available in current volume scan

<Ctrl> + Display 0.5o elevation product in most recent volume scan

A Toggle Auto Update

I Toggle on/off Interpolation function

P Toggle on Plan View in 3DF Panel

C Toggle on CAPPI view in 3DF Panel

X Toggle on/off VDX view in 3DF Panel

FSI Keyboard Shortcuts - For Numeric Keypad Only (Num Lock Must Be on to Work)
Shortcut Description
2 Toggle down in elevation on PPI panel

8 Toggle up in elevation on PPI panel

4 Toggle backward one volume scan

6 Toggle forward one volume scan

3 Toggle down in elevation on virtual volume scan

9 Toggle up in elevation on virtual volume scan

. Toggle between the Base Reflectivity and Storm-Relative Mean Velocity Map products
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Text Display Editor Shortcuts: Selection Functions (Only Applies to the Text Editor Windows)
Shortcut Description
<Shift>+<Home> Changes selection area from current area to start of current line to the beginning of the current selection.

<CTRL>+<Shift>+<Home> Extend selection to top of the document.

<Shift>+<End> Changes selection area from current area to end of current selection to end of the current line.

<CTRL>+<Shift>+<End> Extend selection to bottom of the document.

<Shift>+<Page Up> Extend selection up one screen.

<Shift>+<Page Down> Extend selection down one screen.

<Shift>+ Extend selection to previous character.

<CTRL>+<Shift>+ Extend selection to beginning of previous word (requires words be delineated by spaces, not ellipsis or other char-
acters).

<Shift>+ Extend selection to next character.

<CTRL>+<Shift>+ Extend selection to end of next word (requires words be delineated by spaces, not ellipsis or other characters).

<Shift>+ Extend selection to previous line.

<Shift>+ Extend selection to next line.

Text Display Editor Shortcuts: Delete Functions (Only Applies to the Text Editor Windows)
Shortcut Description
<Backspace> Delete left character or current selection.

<CTRL>+<Backspace> Delete left word.

<Delete> Delete right character or current selection.

<CTRL>+<Delete> Delete from current point or selection to end of the current line.

<F6> Delete right character.

<F7> Delete next word.

<F8> Delete from current point or selection to end of the current line.
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A. Using the <Tab> Key to Change Focus in a D-2D Window

When you open a GUI or window in D-2D, many times you can use the <Tab> key to 
select an object in the interface without using your mouse. Sometimes this method may 
be a more efficient means to completing a task.

In an open window, pressing the <Tab> key several times usually results in the focus 
(usually illustrated by a thin black rectangle around a given window option) changing 
between the different input options in that window. The order in which the focus moves 
with each <Tab> press is called the tab order.

Text Display Editor Shortcuts: Edit and Application Functions (Only Applies to the Text Editor 
Windows)
Shortcut Description
<Escape> (in menu) Move back up one menu level.

<CTRL>+<F1> Start spell checker.

<F2> Open search (and replace) GUI.

<Alt>+<F4> Close text window without saving.

<F5> Print contents of window.

<F10> Bring up first submenu of the main menu.

<CTRL>+C Copy

<CTRL>+P Print contents of window.

<CTRL>+V Paste

<CTRL>+X Cut

<Insert> Toggle between insert and overstrike mode

<Shift>+<Insert> Paste

<CTRL>+<Insert> Copy

<Shift>+<Delete> Cut
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After an item has focus, press <Enter> to select, or deselect, the item if it is a button or check box. If the object is a text win-
dow with a list of options, the arrow keys allow you to highlight an option from the list and pressing <Enter> selects that 
option. Otherwise, if the input object is an input text window, try entering text with the keyboard when the text entry window 
has the focus.

While the ability to select items in a D-2D GUI with the <Tab> order is technically available in almost every window, its 
actual execution can be inconsistent. Do not experiment with this method in an operational time-critical warning environ-
ment; rather, test out several common tasks during times of quiet weather (or during a WES simulation) to become familiar 
with the keyboard interface. The keyboard functions may speed up your workflow by not having to go back and forth 
between the mouse and keyboard, but this is often a user preference.
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Lesson 16: Some Basic Troubleshooting Procedures in AWIPS
This lesson provides instructions on some initial steps to take when D-2D is not performing as expected. This documenta-
tion is very specific to common tasks needed during operations. This lesson does not address areas that should be trouble-
shooted by an AWIPS, Radar, or other staff Focal Point expert or problems supported by the Network Control Facility 
(NCF) or other agency outside the WFO.

A. Fixing Pane Problems in D-2D

Inevitably, D-2D panes do not update or swap in a timely manner. While these situations may be caused by several issues, 
these problems often can be fixed by either clearing the troublesome pane or restarting a pane, which is referred to as a 
“dead” pane. When clearing (or restarting a dead pane) does not ultimately correct your problem, the issue likely requires 
some form of support from either a focal point or NCF.

Task: Restarting Dead Panes in D-2D

This task demonstrates how to restart a dead pane in a D-2D window.

Additional Assumptions:
• None

1.0. Select the Options Menu in the D-2D Toolbar and Press the Left-Mouse Button.

2.0. In the Menu That Appears, Select the “Restart Dead Panes...” Option and Press the Left-Mouse 
Button.

3.0. Restart the Dead Pane(s)
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3.1. If the subsequent GUI says that a pane needs to be restarted, then select the “OK” button in the 
GUI and press the Left-Mouse Button.

3.2. If the subsequent GUI says that all panes are functioning properly, then you can restart the 
main display pane by selecting the “Yes” button in the GUI and pressing the Left-Mouse But-
ton.

4.0. Task Complete!

B. Using the AWIPS Data Monitor

The AWIPS Data Monitor is one of the panels in the AWIPS Sys-
tem Monitor, which provides a status of the AWIPS Data (Radar, 
Point, Grid, Satellite, Local, Graphic, and Disk Usage) and the data 
ingest processes. The AWIPS Data Monitor is the panel in the 
upper left-hand corner of the System Monitor browser window. 
This panel summarizes the status of all these data sets in AWIPS. 
The panel is composed of a table with a data label and a corre-
sponding state value. The state is characterized by one of four 
symbols: a green check mark, a red circle with a white “X”, a blue 
question mark, and a yellow triangle with a black exclamation 
point. Each one of these has a specific meaning.

• A green check mark indicates that data are being received in 
a complete and timely manner.

• A yellow triangle with a black exclamation point indicates that 
data are somewhat late (i.e., more than 20 minutes old) or the data disks are running at a somewhat high level.

• A red circle with a white “X” indicates that data are very late (i.e., more than 40 minutes old) and/or very incomplete.

• A blue question mark indicates that no files are present in the data storage for that data set (i.e., perhaps a dedicated 
radar is down for maintenance for an extended period of time).
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By using the label links in the Data Monitor table, a more detailed listing of products within each data set becomes avail-
able, as well as the respective state of each data product. It is important to look at the detailed listing information. If a sym-
bol other than a green check mark appears in the status column of a particular data set, it could be that only one specific 
product updates poorly. Only by looking at the detailed listing can you see which individual products may have problems.

NOTE: When viewing the Data Monitor, it is important to note that a yellow triangle denotes a problem that is logged by 
NCF, but not necessarily known by NCF controllers. However, a red circle denotes a problem that would be visible on a 
NCF controllers monitor.

Task: Loading and Using the AWIPS Data Monitor

This task demonstrates how to load the AWIPS System Monitor and how to navigate to the detailed listing in the AWIPS Data Monitor.

Additional Assumptions:
• None

1.0. In the Background of the AWIPS Workstation, Press & Hold the Left-Mouse Button.

2.0. In the Menu that Appears, Select the Browser Application and Release the Left-Mouse Button.
• The AWIPS System Monitor is the home page for the browser on an AWIPS Workstation when started in this fashion.

• The AWIPS Data Monitor appears in one of the panels of the AWIPS System Monitor.

3.0. Use the AWIPS Data Monitor to Check the Current State of Data.

3.1. Examine the data sets listed in the upper left-hand portion of the browser window to determine which, if any, of the 
data sets do not have a green check mark.

3.2. To view a detailed listing for a particular data set, select the link for that category and press the Left-Mouse Button.
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3.3. In the detailed listing that appears, examine the individual data product categories to determine which products are 
having a problem.

4.0. Task Complete!


